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Chapter 1: Introduction

Studio DC10plus lets you use your personal computer as a complete video editing
system. Studio DC10plus gives excellent results without expensive, dedicated
video-editing equipment. And, the Studio DC10plus video editing process is an
easy three-step process.

First, capture your video to your hard drive.

Next, arrange the video scenes in order. Drag and drop transitions,
titles and still images. Complete your movie with sound effects, background music
and voice-overs.

Create your final videotape or digital movie.

Interactive Editing with Instant Preview

With Studio DC10plus, you can quickly assemble movies on the fly using an
intuitive, interactive interface. Using the Instant Preview window, you can also play
your movie any time during editing. You see a “what-you-see-is-what-you-get”
(WYSIWYG) view of your movie as you are building it. Just drag and drop video
scenes, transitions, titles and audio (effects, background music and voice-overs).
Then click the Play button to play the movie.

Instant Preview Window

Drag and drop your
clips from the Album
to the Timeline
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Special Effects

Studio DC10plus creates professional-quality scene transitions such as fades,
dissolves and wipes. Studio DC10plus uses some of the same Emmy award-
winning technology found in Pinnacle Systems’ professional editing systems.

Use Title Deko to make simple or elaborate titles, or mix still images with your
video. Adding voice-overs is a breeze—just pick up the microphone, click a button
and start speaking. Audio effects, such as applause or sound tracks from an audio
CD can be added easily using the Studio DC10plus point-and-click interface. The
SmartSound feature creates custom background music quickly and easily—
choose the type of music and its length, and it appears on the sound track.

On-Line Help
On-line help is right where you need it, when you need it, while you’re working in
Studio DC10plus.

• Standard On-Line Help. Click the Help button in the Studio DC10plus main
menu bar, or Press [F1] to display the table of contents page of the standard
help topics.

• Tool Tips. To find out what a button or other Studio DC10plus control does,
pause your mouse pointer over it and a Tool Tip appears explaining its function.

EQUIPMENT REQUIREMENTS

In addition to your Studio DC10plus hardware and software, here is what you need
to make a fully equipped Studio DC10plus editing system:

Computer
PC-compatible computer with:

• Intel Pentium 133 or equivalent processor (CPU)

• Microsoft Windows 95 or Windows 98 operating system

• VGA card, DirectX 5.0 (or higher)-compatible; 256 colors minimum

• 32 MB of RAM (we recommend 64 MB or more of RAM)
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• 30 MB to install software, and between 600 MB and 3.6 GB for every 10
minutes of captured video depending on compression and data rate (data rates
higher than 3 MB/sec may require SCSI Ultra Wide or UDMA hard drives).

• CD-ROM drive

• Sound card, DirectX 5.0 (or higher)-compatible

• Mouse

• Speakers

• A microphone, if you want to record voice-overs

Video Equipment

Source

• Any composite or S-Video source, such as camcorder, laserdisc, TV tuner,
digital still camera, or VCR.

Record

• Any composite or S-Video VCR or video recorder.

Television or Monitor (Optional)

Studio DC10plus provides you with a preview display of your video on your PC
monitor. The optional television or video monitor does not function in Edit
mode. You will see this full-screen display of the Studio DC10plus only in the
Capture and Make Movie modes.

ABBREVIATIONS AND CONVENTIONS

This guide uses the following conventions to help organize the material:

Product Names

Studio DC10plus refers to the complete editing system and the video capture
board. Studio refers to the editing software.
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Dialog Box and Window Names

Names of buttons, dialog boxes, windows and related items are capitalized so you
can find them in the text faster. Here’s an example:

Click the Accept button in the TitleDeko window.

Choosing Menu Commands

The right angle bracket symbol (>) denotes the path for hierarchical menu items.
For example, to create Background Music, the instruction would be

Select Toolbox > Generate Background Music

Keyboard Conventions

Key names are spelled with initial caps. A plus sign denotes a key combination.

Press Ctrl+A to select all the video scenes in the Album window.

Keys that do not have names printed on them are denoted by brackets.

Press the [Spacebar] to display the tool.



2-1

Chapter 2: Installing Studio DC10plus

Section 1. Preparation

Existing Motion-JPEG capture board

If you already have ia video capture board installed in your computer, we
recommend that you uninstall and remove this board before installing the Studio
DC10plus board. To do so, you must also remove the corresponding software
while the video capture board is still installed.

You have two choices: 1. Select Settings in the Start menu, select Control Panel and
System, Device Manager and Sound, video and game controller. Click on your video
board and on Remove. Or 2, check Multimedia Properties to see if a video
capture device exists.

Existing miroVIDEO capture board

If you have a different miroVIDEO capture board installed in your computer, i.e.
miroVIDEO DC1 or miroVIDEO DC20, please uninstall the miroVIDEO driver,
then remove this board from your computer before installing the Studio
DC10plus board.

Or

Insert the miroVIDEO-CD into the CD-ROM drive. Switch to the \tools
directory located on the CD-ROM and start miraser.exe. Confirm the following
messages with OK, restart the system when you are requested to do so.

Defragmenting the hard disk

Before installing and configuring the Studio DC10plus, you should defragment
your hard disk/s. You find the Windows 95 defragmentation utility under Start,
Programs, Accessories, System Tools, Disk Defragmenter.
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SECTION 2: INSTALLING THE STUDIO DC10PLUS SOFTWARE

Install Studio DC10plus like any Windows program. Later, you will configure
certain items to match your specific hardware configuration. Install Studio
DC10plus from the CD-ROM.

Before opening and installing Studio DC10plus, please read the license
agreement in Appendix H. Opening the CD-ROM package means you agree with
the license agreement terms. If you choose not to comply with these terms, keep
the software package unopened, and return the complete Studio
DC10plus package to the point of purchase.

NOTE: Studio DC10plus runs only under Windows 95 or Windows 98. If you have
an earlier version of Windows, you’ll need to upgrade your version of Windows.
Studio DC10plus does not run under Windows NT.

For a normal installation of Studio DC10plus, just insert the Install CD and click
the Next button until you are done.

1 Insert the Studio DC10plus CD in your CD-ROM drive.

If you have the Autorun feature enabled for your CD-ROM, you are automati-
cally given two choices:

• I want to install the software and have some fun! (recommended)
• I want to take a guided tour of Studio.
If you do not have Autorun enabled, navigate to your CD-ROM drive, and
double-click on /Setup/Setup.exe.

2 Click the Next button to accept the default choices for directory and compo-
nents. To continue the installation, click Next in each of the subsequent dialog
boxes. If you prefer, you can make your own choices.

3 When the software is installed, you are prompted to register as an owner of
Studio DC10plus. Choose the easiest registration method by clicking on one of
the three registration buttons, or click Register Later.

When you register, you receive 90 days of FREE technical support (the 90-day
period begins when you first contact Technical Support). Pinnacle Systems
also notifies you of upgrades and other important information.
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4 Click the Finish button.

When the installation is complete, a new group containing Studio DC10plus
icons appears, and you are prompted to restart your computer and install the
Studio DC10plus board as described in the following section.

SECTION 3: INSTALLING THE STUDIO DC10PLUS BOARD

In the interest of your own safety and to avoid damage to your Studio DC10plus
or your computer, please pay special attention to the following:

• Computer components are sensitive to static charge. Divert any electrostatic
charge from your person before touching the components with your hands or
any tools.

• Before opening the computer make sure that the AC power plug is
disconnected.

To install the Studio DC10plus board into your computer:

1 Discharge any static electricity from yourself by touching the metal case of your
computer.

2 Switch off the computer and all peripheral devices. Disconnect the AC power
cord and all necessary cables.

3 Loosen the screws of the computer’s cover and remove the cover.

4 Select a free (busmaster) PCI slot.
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5 Remove the slot shield at the back of the computer. If necessary, remove the
screws at the cover.

6 Insert the board carefully in the selected slot. Hold the board at the top edge
and push both ends simultaneously into the slot. Press the board’s top edge to
make sure that the board is firmly seated in the slot.

If the board cannot be inserted without problems, do not force the board into
place. The contacts at the connector could bend. Instead, pull the board out
carefully and try again.

7 Reconnect the cables. Tighten the screws and reassemble the computer’s casing.
Reconnect all external cables, including the AC power cord.

The Studio DC10plus hardware installation is completed. You can now restart
your computer.

SECTION 4: CONFIGURING THE HARDWARE

The Studio DC10plus Hardware Test is used to test your Studio DC10plus
hardware and to analyze your computer system. You will be shown the following
information:

Driver version information
All the drivers and programs used by the Studio DC10plus, together with their
version numbers, are listed under this heading.
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1  Click Test. To test the hardware, click on Test.

Test modes
This indicates whether all the Studio DC10plus components are operating
correctly. If a faulty function is detected, a corresponding message appears. In this
case, insert the Studio DC10plus board in a different slot and test it again. If
changing the PCI slot does not solve the problem, please refer to Appendix D for
further troubleshooting tips.

If your graphics board supports digital overlay via DirectDraw, this is recognized
in the text and displayed at the bottom. If you change the current resolution,
digital overlay may not be supported at the new resolution level.

If you have specified a very high resolution, color depth, and refresh rate, a
message may appear during testing, stating that digital overlay is not supported.
In this case, reduce the resolution and perhaps the color depth as well, then retest
the hardware.
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2  Start the “Expert” tool

     By pushing the “expert” button you launch the Studio DC10plus’ expert tool:

The main purpose of this tool is to measure the performance of your hard disk
when capturing and playing digital video. If more than one hard drive is
installed in your system, you should generally test all hard drives present and
then use the drive with the highest data rate.

The data rate at which an M-JPEG video sequence can be captured without
dropped frames is calculated from the data rate of the PCI memory link and the
write speed of your hard drive. The recommended image formats, the
corresponding compression factors, and the data rate that can be achieved are
listed.

Select the hard drive of which you want to test the performance, and click on
Start Test. The hard drive should be defragmented so that the results are real
values. You can abort the test by pressing <Esc>. In this case, only the data which
have been read or written are taken into account and the result may be incorrect.
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The hard drive test will first test the speed at which data is written to the hard
drive and/or the speed at which data can be read from the hard drive. It then
calculates the optimum image size with the respective compression factor.

When clicking on Start Test, the Expert hard disk transfer test starts.

First, the Expert tool determines the write speed by saving a file on the hard disk.
Second, it reads the file and determines the read speed. Then, the test utility takes
these data as a basis for calculating the maximum recording data rate or the
minimum compression factor.

If you click the Graphic button, the read and write speed determined by the expert
tool is displayed. The read speed is marked by blue lines, the write speed by red.

Select the hard disk (or disks, if more than one hard disk is installed) you want to
use for recording video. Click Store to use the value calculated by Expert for the
maximum recording data rate. You can select this value by pressing the Default
button. When quitting the program all measured values will be rejected.

Make sure to store the data for the drive you plan to use next for capturing.

The More . . . button lets you determine the file size you want to record. The file
size must be between 10 MB and 2 GB.

The larger the file size, the more precise the result. You can abort the test pressing
<Esc>. In this case, the data which have just been written will be taken as a basis.

Click on Close to close the hard disk transfer program. To complete the
installation procedure, click OK to exit the Studio DC10plus Configuration
dialogue field.

If Studio DC10plus is not working properly, install the video board in a different
slot.

Starting the Studio DC10plus configuration program at a later time

There are two methods of starting the Studio DC10plus Hardware Test at a later
time:

1 By using the Start menu and the commands Programs > Studio DC10plus >
Tools > Studio DC10plus Hardware Test. 
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2 By using the Start menu and the commands Settings > Control Panel >
Multimedia > Multimedia drivers > Advanced > Video Capture Devices >
Studio DC10plus, Motion JPEG Capture/CODEC Board > Settings.

Enabling miroAVI Cache*

NOTE: The Studio editing application uses the miroAVI cache by default for
playback via MediaPlayer. To enable miroAVI Cache manually,

1 Start the Media Player from the Studio program group.

2 Enable the miroAVI Cache (MJPG) menu item from the Devices menu.

Then a file selection window appears where you can open the desired AVI clip.
Please check to make sure that you set the Output options to Composite video or S-
Video in the Studio DC10plus Control program.

* It may occur that miroAVI Cache does not yet allow the playback of video
clips in a window.

After you finish the installation, consider visiting the Pinnacle Web site at
http://www.pinnaclesys.com to download the latest software update from the
Studio Update page.

Now, have some fun…

Now that you have installed Studio DC10plus, you can use it immediately. We
strongly recommend you take this opportunity to experience Studio DC10plus
digital video editing.

In the next chapter, you’ll find a quick, easy and enjoyable tour through the
important parts of Studio DC10plus. You can begin right now—the tour requires
no hardware setup, and all the files are pre-organized on your CD-ROM.
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Chapter 3: The Studio Interface

This chapter is an orientation to the Studio user interface, and describes the main
areas of the screen and the controls you’ll be using most often. Detailed
descriptions are found in later chapters.

As described earlier, you make a movie in three steps: Capture, Edit and Make
Movie. These modes are represented by three buttons under the main menu bar,
and are ordered in the sequence used to make a movie: Capture the video, edit the
video, and then make the movie by recording a videotape or creating a digital
video file.

 ➧  ➧ 
98-02-13 01,2,3

EDIT MODE

When you first launch Studio, it opens in the Edit mode. To return to the Edit
mode from Capture mode or Make Movie mode, click the Edit button on the
main menu bar.

The Edit mode display includes three main areas: the Album, the Player, and the
Movie window.

Album

Player

Movie window

Undo/Redo/Help

98-02-23 02 ILL

In addition, multilevel Undo and Redo buttons are located in the upper right
corner along with the Help button. Clicking Undo repeatedly steps you back
through the previous changes you made. It is essentially unlimited. You can feel
free to experiment with editing because you can always Undo your way back to
where you started.
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The Album

The Album contains four tabs that
access sections for Video Scenes ,
Graphics , Transitions , and
Sound Effects . Click on the tabs to
see their contents.

The Player

The Player displays a preview of the movie, or shows what is selected in the
Album. During Edit, the Player displays a preview of the movie at your current
position. The Player also offers controls to navigate the movie you are editing.

USING THE PLAYER

The Player consists of two main areas, the Preview
window and the Playback controls. The Preview window
displays the video at the current position. The Playback
controls allow you to play the video, or go to an exact
position within it.

98-01-15 01a ILL

The Preview Window

The Preview window is a central
point of focus in Studio because you
use it so often. It displays moving
video during play. When video is not
playing, it displays a still image of the
current position within the movie or
selected object. The Preview window
is also used in functions such as
capture and trimming.

Player
scrubber

Jog
buttons

Transport
controls

Current position
counter

Playback
controls

Preview
window
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The Playback Controls

The buttons and controls in the Preview window let you navigate.

 Start. Moves scrubber to the first frame of your movie.

 Review. Plays the movie in fast-reverse mode at 10x the normal speed.

  Play/Pause. The Play button previews the movie from the current
position. Once preview begins, Play becomes a Pause button. When paused, the
scene or clip on which Preview stopped becomes the selected scene.

 Cue. Plays the movie in fast-forward mode at 10x the normal speed.

Jog Buttons

 Click the Jog buttons to step the movie forward and backward frame by
frame.

Player Scrubber

When a clip is selected in the Album, use the Player scrubber to shuttle forward
and backward through that clip. When clips are dragged into the Movie window,
use the Player scrubber to quickly traverse forward and backward through the
movie. The Player scrubber shows at a glance your relative position within a
movie. Regardless of actual movie length, the scrubber bar represents the entire
length of the movie. The left edge is the beginning.

As you move the scrubber, the Preview window shows the current position of the
movie.

The Counter

The Counter seeks to and displays the current position
within the movie, and also lets you select the exact
point at which to start play.

Hours
Minutes
Seconds
Frames
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To seek to or play from an exact point, click on the number you
wish to change and type a new value.

Counter Shortcuts

• Step through the fields: Tab or Left/Right cursor keys

• Increment/decrement field values: Up/Down cursor keys. Hold the Up/Down
keys to continuously increment/decrement.

Current Position Feedback

Regardless which control you use to change the current position, Studio provides
intuitive feedback on your current position. The feedback mechanisms provide a
range from a big picture view all the way down to the specific frame. In increasing
order of fineness they are as follows:

• With one or more scenes selected in the Album, the Player scrubber shows
current position within the capture file. This is very useful if your album
contains many scenes spanning multiple pages.

• There is also a Timeline Scrubber, which we will discuss later. It shows the
current position within the movie.

• The Progress indicator within the current
scene in the Album or in the Movie window
when in Storyboard view shows the current
position within the scene.

• The Counter displays the exact current position in numerical values.

THE MOVIE WINDOW

The Movie
window menu bar
contains several
important
controls and
displays. The
Toolbox button
on the left opens
the Toolbox,
which is discussed in greater detail in the next section. To the right of the Toolbox

Progress indicator

Movie window
menu bar

View selection buttonsToolbox button

Movie window

File name

Message area
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button is the project file name, along with an area that displays messages about
the action you are performing. To the right are three view buttons.

98-03-11 02 ILL

The Movie window has three views: Timeline, Storyboard and Text. Each one
gives you a different way to look at your movie. You switch between them by
clicking the View Selection buttons in the upper right corner of the Movie
window menu bar.

Storyboard View Timeline View Text View

Storyboard View

The Storyboard view shows the order of video scenes and transitions. It is useful
for quickly structuring a movie.

Timeline View

The Timeline view shows the position and duration of clips relative to the
Timescale. This view also displays the four tracks on which you can place various
types of clips: video scenes, title overlays, sound effects/voice-overs and
background music.

Video scenes and their audio

Title overlays

Background music
Sound effects and voice-overs

Timescale
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Text View

The list in the Text view shows the start and end times of clips, titles and
transitions, as well as their durations. In addition, names for clips are visible in
this view.

Clip Placement Feedback

Studio DC10plus gives you feedback about your actions as you place clips in the
Movie window when it is in Timeline view. Studio does not allow you to create
combinations that cause problems. In fact, Studio gives you messages about what
it is doing in the Status Line, and changes the color and shapes of symbols
accordingly.

The Status Line

The Status line is an area
on the left of the Movie
window menu bar that
displays messages as you
place clips and perform
other actions in the Movie
window.

98-04-06 05 ILL

"Unavailable" symbol

Status line explains why
you see the unavailable symbol
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Placement Symbols

Studio DC10plus does not allow you to create combinations that cause
problems. The mouse pointer symbols and the colors of the vertical Placement
lines indicate what you can and cannot do. For example, if you attempt to drag a
sound onto the Video track, the Placement line turns red, the plus sign becomes
an unavailable symbol, and the Status line tells you “Only scenes, graphics, and
transitions on the video track.”

Green Placement lines with a “copy” sign  mean OK; red Placement lines with
the unavailable sign  mean you cannot perform the action.

These symbols indicate that These symbols indicate “No Go,”
it’s OK to perform the action. and why you cannot perform it.

Unavailable
Placement
symbol

Available
Placement
symbol

Status line
explains why

Green
Placement lines

Red
Placement lines

98-03-18 26

Current Position, Edit Line and Scrubbers

The current position is the frame shown in the Player Preview window. It is also
indicated by the Edit line in the Movie window. The current position can be
changed by moving Timeline scrubber.
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THE TOOLBOX

The Toolbox provides a convenient point-and-click interface to add clips to the
movie and adjust existing clips. The controls in the Toolbox can also be accessed
via the main menu bar and other ways.

The Toolbox is available only in Edit mode, and is opened and closed with the
buttons at the left of the Movie window menu bar.
Open Close

Click the Open button. The Album is replaced by the Toolbox, which contains
two main areas:

• Tool Selector buttons in a panel on the left. Clicking these displays the
corresponding Tools.

• The currently selected Tool on the right. Double-clicking on a clip in the
Movie window also displays the corresponding Tool.

All the Tool Selector buttons, except the first, display Tools with dedicated
functions. The first button (Change Properties of Clip) displays the appropriate
change Tool for the type of clip selected.

Change properties of a video clip

Grab/save a still from a frame of video

Add a title or graphic
Record a voice-over

Create background music with Smart Sound

Add music from a CD

Adjust volumes of audio tracks

Video

Still Images

Transitions

Voice-overs

Background Music

CD Music

Sound Effects



3-9

Change Clip Properties

The Change Properties Tool adjusts the
start and end times of any type of clip.
This is called trimming.  It also allows
you to type in descriptive names.

Grab Frames
This Tool takes a snapshot of a single frame.
You can use it in your movie, or save it for
use in other applications.

Titles and Graphics

Titles and graphics are created and
trimmed with this Toolbox window.

Record a Voice-over

Recording a voice-over is a snap—all
you do is click the Record button and
begin speaking into your microphone.

Create Background Music

The Create Background Music Tool lets
you add or trim background music.
Studio offers a powerful background
music generator. Just choose a Style,
Song, and Version.

Add Audio CD Music

You can easily add audio tracks from
an audio CD, and control their length,
disk name, and track names.

98-03-21 10

Adjust Track Volumes

Studio offers three tracks that can
contain audio: one for the audio from
your source video, and two dedicated
audio tracks (one for sound effects/
voice-overs, and another for
Background Music). The Volume
window displays the audio levels with
volume meters, and lets you control
the volume of each track with respect
to the others.

98-03-21 11
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CAPTURE MODE

The Capture mode enables
you to capture the source
video to your hard drive.
That source video can be a
camcorder, a TV tuner, a
VCR or a live camera. As
the Capture process
proceeds, the Album is
populated with video
scenes and the Player shows
the incoming source video.
Concurrently, the Diskometer monitors the free space on your hard drive. See
Chapter 5 for detailed information on capturing video.

The Player during Capture Mode

During capture the Player shows you the incoming source video, and the
Counter displays an accurate running length of the video being captured.

98-02-23 10

Start/Stop Capture Button

The Start/Stop Capture button begins and ends the capture process.

Diskometer

The Diskometer tells you how much hard
drive space is available in both graphical
and numerical form. The Diskometer also
allows you to select the quality of the video
you capture. The higher the quality you
choose, the more disk space you’ll need for
each second of video captured.

98-02-06 05b ILL

92-02-06 05b ILL

98-03-18 29

Preview monitor

Diskometer

Album

Click here to open or close 
  the option control panels
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MAKE MOVIE MODE

The Make Movie mode allows you to make final videotapes of your movies, as
well as digital versions that are saved to disk.  As the make movie process proceeds,
the Timeline scrubber advances across the Movie window, and the Preview
window shows the clip currently being recorded.

Making Videotapes

The Movie window is visible so you can see the contents of your movie. See
Chapter 11 for more information on how to make videotapes of final movies.

98-02-
23 03

IL
98-02-

05
03a1

ILL



T H E  S T U D I O  I N T E R F A C E

3-12

Making Digital Movies

You can also make digital movies (also called AVI files) to email to your friends
or to put on a Web page. The controls for making a file are displayed by clicking
the disk symbol at the top of the Make Movie window menu bar. This window
includes options for including audio, the type of compression and so forth. In
addition, it contains the Diskometer, which is a convenient way to monitor the
amount of space on your hard drive versus the amount of space used in saving the
digital movie file.
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Chapter 4: A Tour through Studio

The previous chapter gave you an overview of the Studio interface. This chapter
steps you through your first production. You don’t need to hook up any video
equipment to make your first movie. All the files you need are on the Install CD-
ROM, including a sample first production.

In this tour, you’ll learn how to use the user interface to edit movies. Once you
know the basics, learning the details is much easier.

First, you’ll take a peek at a partially completed movie. Then you’ll create this
movie yourself.

The tour is organized as a series of short, easy steps. The first half shows you how
to retrieve a captured video from your hard drive into the Album, add
transitions, and create a title. The second half shows you how to add a sound
effect, create background music, and make an AVI version of your movie.

SECTION 1. ADDING VIDEO SCENES, TRANSITIONS AND A TITLE

About Capturing Video

Normally, the first step in making a movie would be to capture video. However,
this tour is designed so you can install Studio DC10plus and use it immediately
without setting up your video equipment. Consequently, you will skip capturing
video in the tour, which would require connecting a video source to the DC10plus
board. Instead, the Studio Install CD contains pre-captured video called A Day
in the Park. Chapter 5 explains how to capture video.

Take a Peek

First, take a quick look at a partially completed movie to give you a better idea of
the movie you are going to build in the next few steps. Studio is open on your
computer:

1 Select File > Open Project from the main menu bar.

2 Navigate to the folder C:\Program Files\Studio DC10plus\Movies

3 Select the file “Sample1.sdc”
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Studio loads the file and displays the following screen.

…then the Play button

Click the Go To Beginning button…

4 Click the Go To Beginning  button in the Player, then click the Play button and
watch the movie play in the Preview window.

Using the Video Scenes Album

What Is a Video Scene?

After Studio captures video, it subdivides the captured video into smaller units
called “scenes.” Scene detection is based on a sophisticated algorithm, called
SmartCapture, which knows when the incoming video changes enough to
indicate a scene change.

1 Select File > New Project from the main menu bar (or Ctrl+N) to start a new
movie and clear the Movie window.

2 Verify that the Movie window is set to the Storyboard mode. If not, click the
Storyboard View button. 

3 Click on the first video scene in the Album, then click the Play/Pause button on
the Player.

The captured video scenes play sequentially in the Preview window. You also
hear the Audio track from your speakers. As the scenes play, they are selected in
purple. In addition, a progress indicator at the bottom of each scene thumbnail
in the Album indicates your current position. Click the Play/Pause button if
you want to stop.
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4 Select the indicated scene.

Select this scene

98-03-16 01 ILL

5 Click-hold the selected scene, and drag it from the Album to the Storyboard.

Your Storyboard should now look like this:

98-03-16 02

6 Continue to drag scenes to the Storyboard as shown in the following diagram:

98-00-16 03 ILL

Note that the last four scenes are moved as a group. To select a group of scenes,
highlight the group by clicking and holding the mouse button outside the
upper left corner of the group and dragging diagonally to the lower right
corner. You can also click on each scene while holding down the Control key.
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Adding Transitions

Without a transition, one scene begins abruptly after the previous one ends. This
is called a “cut.” Transitions can help you set the pace for your movie, and tell
your story with scene changes that fit your story line.

In this step, you will add several transitions. Your movie will fade up from black at
the beginning. Successive scenes will contain a Dissolve, a Wipe and a Slide.

1 Click the Transitions tab  on the left side of the Album.

The Album displays the Transitions section.

2 Click on the first transition (Fade) to select it.

The Player Preview window shows an animation of the transition effect.

3 Drag the Fade transition in front of the first scene on the Storyboard.

4 Click the Play button on the Player to view the results.

The screen fades up from black before the video commences. To view the effect
again, click Go To Beginning and Play again. To view the effect slowly, click the
To Start button again, and click-hold the One Frame Forward button  .

Now you’ll add two more transitions matched to the content of the video
contained within each scene.

5 In succession, drag the Diagonal Top Right Wipe and Dissolve transitions in
front of the second and third scenes.

    

The beginning of your Storyboard should appear as follows.

98-04-01 06
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6 Preview your video by clicking the Go To Beginning and Play buttons. When
you click the Play button, you’ll see an instant preview of your movie.

Using the Timeline View

The Storyboard view is handy for quickly laying out a movie. To make finer
adjustments, use the Timeline view.

To display the Timeline and adjust the Timescale:

1 Click the Timeline view button  in the Movie window menu bar. At first,
the scenes on the Timeline appear very close together.

98-01-27 10

The default Timescale assumes a two minute movie length. Our example is
short; the scale needs adjustment to make the scenes easier to work with.

2 Position your pointer on the Timescale, until the pointer becomes a clock
symbol with left and right arrows indicating you may adjust the time scale.

Click-drag the Timescale to the right and expand the Timescale as shown
below. Try slowly moving it right and left a little at a time to become accus-
tomed to the “rubber-band” feel.

98-04-01 07 ILL
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To Scrub the Timeline:

Scrubbing is a term that refers to manually previewing the movie by sliding the
Timescale scrubber back and forth. It is very useful to quickly view portions of the
movie, and to go to any point on the Timeline.

1 Click the Timeline button if the Movie window is not in Timeline view.

2 Experiment by moving the scrubber left and right. The vertical bar, called the
Edit line, moves with the scrubber and indicates current position.

Timescale scrubber

Edit line
(current position)

98-03-16 05 ILL

To add a Scene in Timeline view:

1 Click on the Video Scene tab  in the Album to display the video scenes.

2 Drag the first scene from the right Album page to the end of the Timeline.

98-04-01 10

If you try to drop a scene or other clip on the wrong track (or another inappro-
priate location) Studio changes your mouse pointer to the unavailable symbol

 , and does not let you drop it. In addition, the Placement lines turn red and
the Status line displays a message such as “Must drop between clips.” For a more
detailed explanation, see the section “Clip Placement Feedback” in Chapter 3.
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Status line explains why the application
won't let you drop the new video scene 

Status line

98-03-18 25 ILL

You may need to learn the feel by gradually moving to the right until the
cursor comes into contact with the right edge of the Movie window.

 ➧ 

Drag a little more to the right, and the Timeline slides to the left, providing
room into which you may now drop the scene by releasing the mouse button.

Trimming Scenes and Transitions on the Timeline

Long clips can be trimmed to shorten them. In so doing, no data is lost—you are
only setting new start (in) or end (out) points that are easily reset.

To trim a scene on the Timeline:

In addition to the following example, a detailed explanation on handling and
trimming scenes can be found in Chapter 6, Adding and Adjusting Video Scenes.

1 Select the first scene on the Timeline. The scene turns purple.

2 Move your pointer in the vicinity of the right edge of the first scene until the
grabber hand becomes a left-right arrow.

A left- or right-only arrow means you are at the start or end of the video scene,
and there is no more video to trim out.
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3 Click-drag the edge of the first scene a little to the left.

Drag to the left
to trim the clip

98-04-01 12 ILL

As you do so, all the scenes to the right follow along to the left. The first time
you do this, you may be surprised by the large amount of movement that
results from a small amount of cursor movement (by trimming one scene you
are changing the length of the entire movie). But once you practice a few times,
it will seem very natural. If you are not able to move the right edge of the first
scene, make sure that it is still selected.

Adding an Overlay Title

Studio offers powerful capabilities for creating titles and inserting still images into
your movie. The following steps show how to add a basic title.

To add a title or still image, you’ll use an integrated title editor program called
TitleDeko. While doing the following steps, remember that Studio has unlimited
Undo. If you encounter different results than the example, Undo your way back.

To create a title:

1 Double-click on the Title Overlay track below the first video scene.

When you finish the title, Studio places it at the point on the Timeline where
you double-clicked.

98-03-16 03

2 A mini-application named TitleDeko opens with an interface for creating titles.
You might want to take a moment to orient yourself by mousing over the
various buttons to see the Tool Tips (or see a graphic of  the TitleDeko window
in Chapter 9).

98-04-01 14

3 A text I-Beam cursor awaits text entry. Type the words: A Day in the Park. Next,
you will change the type size and apply a new style to it.



4-9

4 Press Ctrl+A. The text is surrounded by a selection box with handles on its
sides. You must select an object before you can modify it.

98-04-01 17

5 To display a sample of Styles, select View > Preset Styles. The Style window
appears to the right of the Preview window. Scroll down to number 5, and
click it.

98-04-01 19

6 The style characteristics are applied to the text.

7 Click the Move/Resize Tool button  . To resize the text, position the cursor
on the lower right handle while pressing the Control key to proportionally
shrink the text.

98-04-01 18 ILL

Next, you’ll center the text.

8 Click the Horizontal Justify button  , and then click the Center  button.

9 Your title appears as follows:

98-04-01 21

10 Finally, select the Accept button   located in the top right corner of the
TitleDeko window.
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Return to Studio TitleDeko. Studio places the title under the first video scene,
because that is where you double-clicked on the Title Overlay track to launch
TitleDeko.

Title appears where you originally 
clicked in the Title Overlay track

98-04-01 22

Trimming the Title

You trim titles (or any other still image) just like you trimmed the video scene
previously. The one exception is that you always see a left-right arrow because a
still image can always be made longer, whereas a video scene contains a finite
amount of video.

Keep the screen as it is, the next step is adding transitions to the title overlay you
just created.

Adding a Title Transition

You can add transitions to titles just as easily as to video scenes.

To add a transition to a title:

1 Click the Transitions tab  on the Album

2 Drag and drop two Slide Right transitions onto the Title Overlay track before
and after the title overlay.

  

98-04-01 23-26

3 Preview the movie by clicking the Player Go To Beginning    and Play 
buttons.
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When the movie plays, watch how the title slides in from the left, pauses for a
moment, and then slides off to the right.

SECTION 2. ADDING SOUND

About Studio Audio Capabilities

To complement the audio from your videotapes, Studio offers audio capabilities
that let you add WAV files and audio tracks from CDs to your movie. You can
also easily record voice-overs, and automatically generate background music.

This section of the tour shows you how to add a WAV sound effect and generate
background music.

To add a WAV sound:

1 Click the Sound Effects tab  .

2 The Album displays the section for Sound Effects. The page is populated with
sound files.

3 Click on any sound icon to hear a preview.
98-04-01 27

4 Click-hold on the WAV file CarHorns and drag it to the Sound Effects track.
Release the mouse button and the sound appears on this track.

Sound effect &
voice-over track

98-04-01 28

Note: If your cursor displays an unavailable sign,  you are not over the correct
track, and need to move the pointer a little lower. The Status line tells you
what you need to do.

90-01-28 04
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5   Click Go To Beginning and Play buttons to preview the movie. As the car
drives up, you hear the horn honk.

Creating Background Music

With SmartSound, you can create background music with a few mouse clicks.
SmartSound automatically creates a song that matches the length of the scenes
you select in the movie. Regardless of the length, the resulting music always has a
proper beginning and ending.

The first step in creating background music is to tell Studio how long you want it
to be. The easiest way to do this is to select the scenes over which you want the
music to play.

1 Select a range of scenes over which you want the background music to play. In
this case, it will be the entire movie. Click on the first scene, hold down the Shift
key, and click on the last scene.

2 Click the Toolbox button  in the upper left corner of the Movie window
menu bar. The Toolbox opens.

3 Click the Create Background Music button  .

You are prompted to insert the Studio DC10plus Install CD, which is where the
sound files are located, unless you elected to copy these to your hard drive
during installation. After you insert the CD, the Create Background Music tool
is displayed.

98-04-01 01

4 Select the Style (Country/Folk), Song (The Great West) and Version (The
Theme).

5 Click the Preview button to hear the resulting background music. Click again to
stop.

6 Click the Add to Movie button.

An audio clip containing the background music is placed on the Background
Music track.
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7 Preview the movie by clicking the Player Go To Beginning   and Play 
buttons.

Congratulations. You have made your first Studio movie. Next, you will output
your movie.

SECTION 3. MAKING A MOVIE

Now that you have scripted your movie, you have two ways you can output it.

• Save to disk as a digital movie

• Output to videotape

In this section, you will make a digital movie (also known as an AVI file)—a quick
and easy process. Normally, you’ll create a videotape. However, the process of
creating a videotape is saved for later in this guide.

Saving as a Digital Movie

You can save your Studio movie as an AVI file if you want to use your movie in a
multimedia presentation on your computer, send it to a friend via e-mail, or post
it on a Web page. AVI movies can also be brought into other video applications as
clips.

An AVI is a complete file unto itself. It can be played by any AVI player, including
the Microsoft Media Player built into Windows 95 or Windows 98.

Output to Videotape

Outputting your Studio movie to videotape is a little different from making an
AVI movie because it requires having a VCR connected to the Studio DC10plus
board. This is covered in detail in Chapter 11.
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To make and play a digital movie:

1 Click the Make Movie button   the main menu bar.

The Make Movie window is displayed along with the Make Tape controls.

2 Click the Make File button  in the Make Movie window menu bar.

98-02-23 01

The Make File controls replace the Make Movie controls.

3 Click the Make Movie button.

4 When you do so, Studio begins the Make Movie process. A dialog box shows a
progress bar.

The AVI file is saved in the folder C:\Program Files\Studio DC10plus\Movies
with the same file name as your project, except that the extension is .avi
instead of .sdc. You can save or navigate to a different folder by clicking the
File Cabinet button  .

5   To view the results, use Windows to navigate to the folder in which you saved
     your original Studio movie. Double-click on the .avi file.

The Microsoft Active Movie Controller launches automatically and plays the
AVI movie.

90-01-28 08
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Chapter 5: Capturing Video

Capturing digitizes video that you use in Studio editing sessions. During
capture, your source video passes through the Studio DC10plus board where it is
digitized and stored on your computer hard drive. After the video is captured,
the Studio software can perform automatic detection, and populates the Album
with scenes. Once you’ve captured your video, you script it by editing scenes,
inserting transitions, creating titles, and adding sound effects. Finally, you make
a tape or a digital movie.

Section 1. About Capturing

During capture, you have complete control over the video and audio you choose
to digitize. It’s common to capture multiple clips of video for a project, clips that
were shot on different days, under different lighting conditions, even with
different cameras.

Video Controls

This is where you choose the type of video signal you wish to digitize (composite
or S-Video), your video capture quality, and how video levels are set (brightness,
contrast, sharpness, hue and color saturation).

Audio Controls

This is where you choose how high or low you set individual clip audio levels,
whether you capture stereo or mono audio, and at what sample rate you capture
your audio. If your clips are picture only, you can turn audio capture off and
save disk space.

After the capture process, Studio can detect each edit or scene change on your
source video, and create a separate video scene in the Album. You then use the
Studio editing capabilities to choose those scenes you want in your final movie
from the Album containing all the available scenes.

The following sections explain the controls in the Capture window, along with
some notes about the capture process. Subsequent sections explain how to
capture in detail, using easy-to-follow steps.



C A P T U R I N G  V I D E O

5-2

THE CAPTURE WINDOW

First, you must be in the
Capture mode. Click the
Capture button  in
the Movie menu bar. The
Capture window is dis-
played in the following
illustrations, and is com-
posed of three areas: the
Album, the Preview moni-
tor,  and the Diskometer.

The Diskometer

The bottom half of the Capture window contains the Diskometer. The
Diskometer shows the amount of
space on your hard drive and how
much space is available for the
current capture. It also contains
four Quality button pre-sets that
let you select different video
capture qualities. The higher the
quality you choose, the more disk
space you’ll need for each second of
video capture. There are option
control panels which slide out from either side of the Diskometer. To the left of
the Diskometer is the Video Capture options, and to the right is the Audio
Capture Options control panel.

Folder Browser

The default location for captured video is C:\Program Files\Studio
DC10plus\Captured Video. To save newly captured videos to a different location,
click the File Cabinet button  to display a Browse for Folder window.

Shows space remaining 
on current disk drive

Shows time remaining
at current Quality setting

Quality setting 
push buttons

Preview monitor

Diskometer

Album

Click here to open or close
  the option control panels 
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Disk Space

Disk space availability is indicated in two ways. A Disk Space pie chart shows
used and available space. In addition, the Diskometer also shows the amount of
capture time available at the current Quality setting.

When Studio captures video, it digitizes
the video and allows you to choose the
quality at which the video is captured.
The higher the quality, the more disk
space you’ll need for each second of
video. You can choose four quality
settings using the push buttons.

9

About SmartCapture Automatic Scene Detection

SmartCapture is a key feature of Studio DC10plus. SmartCapture’s automatic
scene detection eliminates the drudgery of manually marking the beginning and
end of video scenes. When Studio captures your source video to your hard drive,
it automatically detects natural breaks that occur in that video. For example, the
Studio software knows when a camera operator stopped shooting one scene and
began reshooting. Studio automatically creates separate scenes for you when it
detects these situations. SmartCapture saves many hours of tedious scene
logging, so you can move right onto drag-and-drop video editing.

The way Scene Detection operates depends on the options you select. The Scene
Detect Options are found at Setup > Edit, and present three choices:

• Selecting Do Automatic Scene Detection enables Automatic Scene Detec-
tion.  If you do not want a particular scene to begin or end at the points
Studio has chosen for you, it is easy to combine or split scenes.

• Selecting Create A New Scene Every X Seconds directs SmartCapture to
create a new scene thumbnail every X seconds (where X is a number you
choose).

• Selecting Do Nothing bypasses Automatic Scene Detection entirely, and
your Album displays a single thumbnail of the initial frame of that video
capture file (all scenes are captured together).
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Automatic scene detection can occasionally produce unwanted scene changes
under unusual lighting circumstances. For example, a video shot in a nightclub
with a strobe light would produce a scene each time the strobe light flashed.
However you can easily combine these scenes into a single scene.

Conversely, video shot in a situation where there is very little change in
brightness produces the opposite result: too few scenes detected.  Fortunately,
there is an easy solution to this condition: subdividing scenes.

Troubleshooting Tip: avoiding too many scene changes

Automatic scene detection is sensitive to abrupt changes in brightness, and can falsely
detect scene changes under some circumstances.

• Weddings and other events where a large number of people take flash photos

• Other flashing lights, such as nightclub strobe lights and emergency vehicle lights

• Sunlight reflected on moving surfaces

• “Whip pan” shots in which the camera pans fast instead of making an edit

Troubleshooting Tip: avoiding too few scene changes

• Stationary cameras or stationary subjects

9
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Section 2. Connecting the video devices

This section shows you how to connect your video devices to the Studio
DC10plus board. To do so, you need suitable cables.
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VID IN

VID OUT

COMPOSITE
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S-VIDEO INPUT

S-VIDEO OUTPUT

END VIEW

Inputs

The Studio DC10plus has one composite input and one S-Video input, enabling
parallel connections of two video sources. The software switches between the
video inputs. The composite input is an RCA female connector, the S-Video
input is a 4-pin Mini DIN female connector.

Connecting video devices

Video inputs

• If you have a Hi8 or S-VHS video source with S-Video output, connect it to
the Studio DC10plus’ S-Video input with a suitable cable (4-pin Mini DIN to
4-pin Mini DIN).

• If you have an 8mm or VHS video source with Composite video output,
connect it to the Studio DC10plus’ Composite video input with a suitable
cable.
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Audio inputs

• Connect the audio output of your video source to the Line In or Mic In of
your PC sound card. (See Appendix D for sound card Line In/Mic In
information). You will need an RCA-to-stereo-mini-plug cable. You probably
received one with your sound card (if not, they can be purchased at most
computer or consumer electronic stores). If your video source has a mono
audio output, use the left (white) RCA jack.

Section 3. Capturing Video

The following sections explain what happens during capture, and guide you
through a capture session from start to finish.

To capture video:

1 Verify the source video is connected to the Studio DC10plus card Composite
or S-Video input.

2 Verify the source audio is connected to the audio inputs of your PC’s sound
card.

3 Click the Capture button  in the Movie menu bar. The Capture Mode
interface is displayed.

4 Select Quality—the higher the Quality, the larger the captured files. You are
presented with 4 choices (each choice has differing picture size and compres-
sion characeristics; refer to Appendix A for details):

•   Good quality is comparable to multimedia or CD-ROM video quality

•   Better is comparable to VHS videotape

• Best is comparable to SVHS videotape

• Custom can be any quality you choose (depending on the capabilities of
your hard disk)

5 Click the Start Capture button  . The Capture Video dialog box

is displayed.
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6 Type in a name for your source video. Next, enter the duration for this cap-
ture. Note that Video for Windows does not allow captures larger than 2GB.
Studio will calculate the duration of video that will fill 2GB at the selected
quality, and display this as the maximum duration for this capture.

7 If you’re capturing pre-recorded material, start your playback device.

8 Click the Start Capture button in the Capture Video dialog box.

During capture, the Preview window displays the incoming digitized video
that is being saved to your hard drive.

9 Click the Stop Capture  button   to end capture at a point you

select (the Start Capture button toggles to a Stop Capture button while you
are capturing video).

Studio automatically stops capture if your hard drive fills up or when the
duration you entered is reached.

Studio will perform Automatic Scene Detection based on your setting in the
SmartCapture Options dialog box (Setup > Edit).

CAPTURE OPTIONS

Studio provides slide-out Option control panels for video and audio capture
options to suit either your work style or your specific equipment configuration.
This section provides a summary. See Appendix A for more information.

Capture options
affect both the video
and audio you are
digitizing. This is a
critical point in the
non-linear editing
process, since you
are locking in the
brightness, contrast,
hue and saturation
values of each clip
you digitize. This

becomes significant when you mix different video sources within a single project.
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Audio Options

You can digitize the audio that accompanies your video by clicking the Audio
Capture On button. If your clip is video only, click the Audio Capture Off button
to save disk space. The slide-out Audio options tray includes settings for Volume
and Balance.

The Edit Options tab includes settings for Sample Rate and Channels (see
Appendix A). Sample Rate affects the sound quality and also the file size. The
higher the quality, the larger the file.

Video Options Tray Audio Options TrayAccess Option Tabs

Setting your video options correctly as you capture will give your project
consistancy from beginning to end in terms of flesh tones, brightness, and
contrast. Setting your audio options correctly as you capture will ensure
consistent volume levels and audio quality.

Video Options

First choose the type of video you wish to digitize by clicking the appropriate
Source button (S-Video or composite). The slide-out Video Options tray then
allows you to control the brightness (video gain), contrast (video black level),

sharpness,  hue,
and saturation of
each video clip
digitized.
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Chapter 6: Adding and Adjusting Video Scenes

This chapter explains how to use video scenes. You learn how to open a
file of captured source video, and how Studio detects and creates an Album of
scenes from which you can assemble your movie.

The process of creating a movie starts with capturing source video clips. If your
hardware is connected, capture and use your own video for the examples in this
chapter. If not, use the pre-captured video,  A Day in the Park, which was installed
along with the other Studio software if you performed a default installation.
Capturing was explained in Chapter 5.

SELECTING AND OPENING A CAPTURED SOURCE FILE

Captured source video files are stored on your hard drive. They are selected and
opened with standard Windows file/folder navigation tools found at the top of the
left Album page.

Note that Studio can combine video files of different qualities within a movie, but
at a price. If all the files in your movie have the same quality, Studio does not have
to render the entire movie before you can output it to videotape. If, however, you
use captured source files of different quality, Studio must render the entire movie,
which may be quite time-consuming.

To open and select a captured video:

1 If the Video Scenes section of the Album is not already on top, click the Show
Videos tab  on the left edge of the album.

The Album flips to the Video Scenes section and displays file navigation tools
in the upper left corner.

98-02-25 03

2 Select a video from the drop-down list, or press the File Cabinet button   to
navigate to a different folder.

The Album is now populated with the detected scenes from your captured
video. Each scene is denoted by a picture of the first frame of the scene.
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SELECTING MULTIPLE SOURCE FILES

For some projects you may want to combine scenes from separate source tapes,
or scenes from the same tape captured as separate video files. Studio makes this
easy:

1 Drag and drop scenes from the first captured video file into the Movie
Window.

2 Using the drop-down list or the File Cabinet button, open the second cap-
tured video file. Studio displays only your current file in the Album, al-
though previous clips remain in the Movie Window until they are deleted.

3 Drag and drop scenes from the second captured video file into the Movie
Window. Continue in this manner until you have all desired scenes in the
Movie Window.

If you intermix captured video files of differing quality, Studio displays a warning
message alerting you that all lower-resolution clips will be re-rendered at the
highest resolution in the project, resulting in increased rendering times for Make
Movie.

REVIEWING VIDEO SCENES IN THE ALBUM

Scenes are displayed in the order in which they were captured. This order cannot
be changed in the Album, but scenes can be assembled in the movie in any order.

After you have opened your captured video, you may want to review the scenes
and make adjustments before placing them on the Video track. You can decide to
combine, split or detect new scenes within specific scenes. However, the sequence
of scenes within the Album always remains in the order in which you digitized
your video clips.

Immediately after selecting the captured video, the Preview window displays the
first frame of the first scene. When you select a scene, the Preview window
displays the first frame of that scene. To play back the contents of the Album
from the current position, click the Play/Pause button  .
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To review the captured video starting from a selected scene:

1 Click on the first scene to select it.

The Preview window displays the first frame of the selected scene.

2 Click the Play button  in the Preview window.

The Preview window now plays the scenes in the Album. Progress is indicated
in three ways:

• Studio highlights the scenes successively as the are played.

• The Player scrubber in the Preview window shows the current point of play
relative to the entire captured file.

• Each Scene window contains a Progress indicator that shows the point of
play relative to that scene. As the movie continues to play, the Progress
indicator travels from scene to scene.

Progress indicator

Displaying Scene Start and Length

As you move the pointer over scenes, the pointer changes to a grabber symbol. If
you pause momentarily on the scene, the start time and length is displayed.  Note
that the start time is the time on the original tape.
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Selecting Scenes

Studio offers a variety of ways to select scenes in the Album and in the Movie
window. Selection techniques follow standard Windows conventions. Selected
scenes are indicated by a highlighted border. You can use combinations of these
techniques.

• Choose Edit > Select All from the menu bar, or press Ctrl+A to select all the
scenes in the Album, including subsequent Album pages not visible.

• Shift-click to select a range of continuous scenes.

• Ctrl-click to select discontinuous selections.

• Click-hold-drag to highlight a group of scenes.

• Press the arrow keys to navigate through the Album grid.

TRIMMING SCENES

Video scenes and other clips that are too long can be trimmed to remove the
excess. Unlike traditional trimming processes, no data is lost: Studio sets new start
and end points for the clip in the Movie window, but does not alter the original
Album scene. This means you can always reset scenes to their original state, or
select different trim points.

Studio offers two ways to trim:

• Directly on the Timeline

• With the Trim tool

The basic process involves selecting a point near the beginning of the scene to
which you want to trim (the “in” point). Once this point is selected, the Trim
command trims the excess from the beginning of the scene to this new point.
Trimming from the end (the “out” point) works the same way.

Trimming on the Timeline

The quickest way to trim is by dragging the edges of scenes directly on the
Timeline (this is one of three Movie window View Selections—see Chapter 3).
Watch the Preview window as you trim, so you can find the frame on which you
want the scene to end or begin.
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It takes a little practice to become accurate with this technique, but once you do,
it is very fast. The easiest way to learn is with only one scene on the Timeline, as in
the following example:

To trim a single scene on the Timeline:

The following exercise shows how to trim scenes directly on the Timeline by
trimming the end of the first scene.

1 Delete all but one scene from the Timeline. If no scenes are on the Timeline,
drag one to it from the Album.

2 Fine adjustments are easier when the time scale is expanded. Expand the time
scale so the scene resembles the following illustration.

Position the pointer anywhere on the Timeline except directly over the Edit
line. The pointer becomes a clock symbol; click-drag it to the right to expand
the Timescale.

01-14-98 15

The illustration above shows maximum expansion. Each tick mark represents a
single frame.

3 Position your mouse pointer over the right edge until it becomes a left-right
arrow.

98-01-18 02, 98-03-16 13

4 Click-drag to the left. The Preview window shows the current frame. As you
trim, the frame displayed in the Preview window becomes the last frame.

98-01-18 04

Release the mouse button. The scene is now trimmed.
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98-01-18 04

To trim with more scenes on the Timeline:

When more than one scene is on the Timeline, you first need to select the scene to
be trimmed.

1 Select File > New Project  to open a new file, or simply delete all the scenes from
the Timeline (press Ctrl+A, then Delete).

2 Drag the first two scenes from the Album onto the Timeline. (If you are using
A Day in the Park, note that the Timescale is relatively short.)

98-01-18 05

3 To expand the Timescale, right-click in the time ruler. Choose 30 seconds from
the pop-up menu.

98-01-18 06

4 Select the left scene. Your Video track should now look like the following:

98-01-18 07

5 Move your pointer over the dividing line between the two scenes until it
becomes a left-right arrow.

90-01-18 08, 98-03-16 13

6 Click and drag the edge to the left. Note how the Preview window changes.
98-01-18 09, 98-03-16 14

7 The scene is now trimmed and should appear as follows:

98-01-18 10, 98-03-16 15
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Note that the last frame of the first scene is displayed in the Preview window.
As long as the left scene remains selected, you can continue to trim more video
by dragging the edge to the left again, or restore some of the trimmed video by
dragging the edge to the right.

8 Select the second scene. Move your cursor over the left edge of the second scene
until it become a right arrow.

98-01-18 12, 98-03-16 16

9 Drag the left edge of the second scene to the right.

98-01-18 12, 98-03-16 17

10 Release the mouse button. The left edge of the second scene snaps back against
the right edge of the first scene.

98-01-18 14, 98-03-16 17

The beginning of the second scene is now trimmed. The first frame of the
second scene is displayed in the Preview window.

Troubleshooting Tips

If you are having difficulty manipulating the edges of scenes, try the following:

• Verify that the scene you wish to trim is selected, and that it is the only scene
selected.

• Expand the Timescale until it is easier to make fine adjustments.

• Be careful not to expand the Timescale too far. If that does happen, scenes will
appear very long. Undo enough times until the scale is restored, or use the scale
tool to reduce the Timescale.
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Trimming Video Scenes with the Change Clip Properties Tool

The Change Clip Properties tool provides a convenient place to perform
trimming functions for any type of clip, including video scenes. It includes the
benefits of the prior two methods in that you can perform precise and fast
trimming. As you work, you receive visual feedback. Once you have completed a
trim, you can preview the scene to make sure you like it, and reset it if you don’t.

Click the button at the left of the Movie window menu bar to open and close the
Toolbox, or double-click on the clip in the Movie window.
Opened Closed

Orientation to the Change Clip Properties Tool

When trimming video scenes, the Change Clip Properties tool is configured as
shown in the following illustration. On the left and right the beginning and
ending frames are shown. In between these is a set of Transport controls that play
the scene as you are working. A set of Trim Calipers is found at the bottom. At the
top are a Name field on the left and a Duration field on the right.

Start frame
preview

Transport
controls

End frame
preview

Name field Duration field

Trim calipers
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Start/End Trim Scene Preview Windows

The Trim Scene Preview windows show the first and last frames of the scene.
Before you trim, they display the first and last frames of the original scene in the
Album. As you trim, they display the new start and end frames.

Trim to
current
position

Last frameFirst frame

Amount trimmed
from start 

Scene
duration

Changes counter
by frames

Trim to
current
position

98-03-02 05b ILL

At the bottom of the Preview windows are several controls for setting trim
points. The left and right Trim To buttons with bracket symbols trim the start
and end to the current frame shown on the Player. The Counter displays the
current start/end times. You can also manually type in values on the Counter to
set new trim points. The Up/Down arrow buttons increment/decrement the
current position by single frames.

            

The Player Window During Trimming

During trimming, playback is controlled from the Toolbox, and the Preview
Player controls are not displayed.
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Using the Movie Window Scrub Slider

A convenient way to rapidly move to the general area you want to trim is to use
the Timeline scrubber in the Movie window. As you move it, the Trim scrubber
and Player scrubber track its movements.

As you move the Timeline scrubber...

… the Trim and Player scrubbers
track its movement

Transport Controls

Between the Start/End Preview windows is a set of Transport controls.

To trimmed start time

To original start time

Play/Pause

Loop

98-03-02 05d ILL

From left to right their functions are as follows:

• Click the left-most button  to go to the untrimmed start of the scene.

• Click the second button  to go to the new trimmed start time.

• The third button  plays the scene, and changes to a Pause button 
during play. The Player stops when you click it a second time.

As you play, the Trim scrubber moves from one segment to the next so you can
accurately review the trimmed and untrimmed portions.

98-03-16 18 ILL

• Click the right-most button  to loop the scene continuously.  The button’s
function changes to Pause.
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Trim Calipers

The Calipers provide a fast way to make accurate trims, and provide instant
graphical feedback on how much you have trimmed. Slide the left and right
markers to the point at which you want the scene trimmed. Move the Trim
scrubber to scrub the trimmed scene.

Amount trimmed
from start

Trim
scrubber

Trim start
caliper

Trim end
caliper

Amount trimmed
from end

98-03-02 05f ILL

Duration Counter

This Counter shows the length of the scene, and operates in the same way as other
counters in Studio. However, changing its value manually increases or decreases
the scene length by adding or subtracting from the end of the scene.

Up/Down 
by frames

Duration in
H:MM:SS.F

98-03-02 05e ILL

Scene Name

You can give your scenes names that are more meaningful to you by typing them
in this box. These names are visible only when the Movie window is in Text view.

98-03-06 04

Tip: to see the new name, move the cursor over the scene’s thumbnail in the
Album or on the Storyboard.

Resetting Trimmed Scenes

You can Undo if you don’t like the results of a trim, or you can manually reset the
trimmed scene.

Use one of the following ways to reset a trimmed scene:

• Drag the scene edge directly on the Timeline until it stretches no further, or
drag the Trim tool to the end.
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• Use the Trim tool to drag the Caliper to the end.

• Use the Trim tool, but click  to go to the clip start; then click  under the
first frame preview window to set the start frame.

SPLITTING CLIPS

If you want to insert another scene or a still image into the middle of a clip, you
can split any type of clip on the Video track in the Movie window into two parts
and then insert the new item. This includes video scenes and still images.

To split a clip in the Movie window:

1 Place the clip in the appropriate track in the Movie window.

2 Choose the split point.

You may use any method that adjusts the current position, such as moving the
Timeline scrubber, clicking Play and then Pause, or changing the Counter.

3 Right-click within the Movie window Video track, but not on the scene itself.
98-03-16 11.tif

4 Select Split Clip from the drop-down menu.

The clip is split at the point of the current position.

To split a scene in the Album:

1 Select the scene.

2 Use the Play controls to locate the point you wish the scene split.

3 Right-click on the scene and select Split Scene from the menu.

Restoring a Split Clip

To restore a split clip you can Undo, replace it, or use the Trim tool. To restore a
split clip:

• First try to Undo. Even if you performed other actions after you split the scene,
the multilevel Undo allows you to restore the split scene.

• If you elect not to Undo other actions as well, you can replace both halves of
the split clip with an original from the Album, or . . .

• Delete one half of the split clip, and trim out the other.
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Combining and Subdividing Scenes

SmartCapture automatic scene detection is very fast and a great labor-saving
tool; however, you might not want a particular scene to begin or end at the
points Studio DC10plus has chosen for you.

You might want to combine multiple scenes into a single scene or split one scene
into smaller scenes. Both techniques are easy, and are similar to each other. These
operations are accomplished on the scenes in the Album, not in the Movie
window.

To combine scenes in the Album:

1 Select the scenes to be combined.

2 Right-click on one of the scenes.

3 Choose Combine from the pop-up menu, or select Album > Combine Scenes
from the main menu bar.

01-14-98 11

The selected scenes are combined into one. Only selected adjacent scenes are
combined. Furthermore, they are joined in the order in which they appear in
the album, regardless of the order in which they were selected. Album order
proceeds across rows and then down the page. To revert, press Ctrl+Z, or click
the Undo button.

Non-adjacent scene is not combined

98-01-18 02 ILL
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If you highlight two or more discontinuous sets of scenes using the shift-drag
technique, each set of adjacent scenes is combined, but the two sets are not
combined with each other.

98-01-18 03 ILL

To subdivide scenes in the Album:

1 Select the scenes to be subdivided.

2 Right-click on one of the scenes.

3 Choose Subdivide from the pop-up menu, or select Album > Subdivide Scenes
from the main menu bar. The Subdivide Selected Scenes dialog box appears.

4 Choose the length of the subdivided scenes by typing in a value.

The smallest increment of subdivision is one second. Any video remaining after
subdivision is added to the last scene.

5 Click OK.

A progress bar appears, the scene is subdivided, and new scenes are added to
the Album. To revert, press Ctrl+Z, or click Undo.

You can subdivide these scenes still further, provided they retain a duration of at
least one second. To split a scene in the Album:

1 Select the scene.

2 Use the Player transport controls to locate the frame where you wish to split the
scene.

3 Right click in the screen and select Split Scene.
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Re-Detecting Scenes

If you combine or subdivide scenes and later decide that you’d prefer to revert to
their original state, you may re-detect any scene or selection of scenes. The
detection results are identical to those that resulted from opening the captured
video.

To re-detect scenes:

If you have subdivided scenes, you must first recombine them. Even if you cannot
remember exactly what you did and recombine more than is necessary, the
detection process will restore the original scene sequence.

1 Select any scenes you have subdivided, right-click on one of the selected scenes,
and chose Combine Scenes from the pop-up menu.

2 Select the resulting scenes that you wish to re-detect.

3 Right-click on any of the selected scenes and choose Detect Scenes from the
pop-up menu.

The following window appears as Studio DC10plus redetects the scenes and
repopulates the Album with the original scenes.

To change thumbnails in the Album (Studio uses the first frame of the Scene as
the thumbnail; you can easily select a different frame for the thumbnail):

1 Select the scene to be changed.

2 Use the Player control to find the frame you wish to be the thumbnail.

3 Right-click on the scene and choose Set Thumbnail from the pop-up menu.
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Chapter 7: Creating and Using Still Images

Studio offers a variety of capabilities for creating and using still images. You can
import images, such as photographs or drawings in most standard formats, and
video frames, which can be grabbed with the Studio DC10plus Frame Grabber.
Titles are also a type of still image, and may themselves contain imported images
and grabbed frames. This chapter explains how to place still images, such as
photographs, into your movie, and how to use the Frame Grabber to make a still
image from a single frame. Chapter 9 explains how to create titles.

Still images can be placed on the Video track or the Title Overlay track. Still
images on the Title Overlay track are superimposed on top of the video.

When you place a still image in the Movie window, a copy of the image file is
imported into the Studio project. This makes the Studio project more
transportable; however, changes to the original image file are not reflected in the
Studio project. If you change the original image, replace the image in Studio.

Full Screen Images

A full screen image is one that is placed on the Video track, and fills the entire
screen, replacing the video. When the preceding video clip ends, Studio plays the
still image clip. The visual effect is that the video ends, and is replaced by the
graphic until the next video clip or still image begins.

A Full Screen Title Replaces the Video

 ➧  ➧ 

9



7-2

C R E A T I N G  A N D  U S I N G  S T I L L  I M A G E S

Overlay Images

An overlay image is placed on the Title Overlay track and is superimposed on
top of the moving video, without replacing the video. The video continues
playing in the background, while the overlay image appears stationary in the
foreground. The visual effect is that a still image, such as title words or a
graphic, appears on top of the video.

An Overlay Appears on Top of the Video

 ➧    ➧  

To add a full screen still image:

Still images such as photographs, clip art and titles are added from the Graphics
section of the Album.

1 Select File > New Project from the main menu bar to clear the Movie window.

2 Click the Show Video tab  on the Album, and drag two video scenes onto
the Timeline.

3 Click the Show Graphics tab  on the Album.

The Album Graphics section is displayed, along with a set of default images (if
you chose to install them). You can use your own images by clicking the File
Cabinet button  and navigating to the folder containing your images.

4 Drag a still image in between the two video scenes.
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5 Click the Play button in the Player to preview the movie.

Don’t clear the Movie window yet, because we will be adding an overlay image
later.

About the Overlay Process

Overlays are created in two ways. The primary method is through the title editor
TitleDeko; however, you can also import a still image file. TitleDeko is covered in
Chapter 9. This chapter explains importing graphics as overlays.

An overlay still image appears to have a solid background, yet—when you place it
on the Title Overlay track— the background disappears, allowing the video to
show through. How does Studio DC10plus do this?

Controlling Transparency for Still Images

For still images placed on the overlay track, Studio DC10plus uses the color of the
top-left pixel of the image to determine the transparent color. All pixels that match
this color are assigned Opacity of 0% (fully transparent or clear). Because these
pixels become transparent, the pixels of video behind them show though.

This function works well for still images that have consistent solid background
colors. However, if you find that your particular overlay image background color
does not work well for this, change the color Studio DC10plus uses for the
background. You can use an image editing program to change the top-left pixel to
the desired color.

Please note that graphics imported into TitleDeko are not given transparent
backgrounds.

To add an overlay still image:

The Graphics section of the Album should still be open. If not, click its tab.

1 Drag a still image from the Album to the Title Overlay track under the first
video clip on the Timeline.
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 2  Play the movie to see the overlay effect.

     

The top-left pixel of the overlay image is black. Studio makes all the black
pixels in the overlay image transparent, allowing the video to become visible
in the background.

THE FRAME GRABBER

The Frame Grabber can capture a still image from any video source, and save it
in many standard graphic formats. You can use the grabbed frames in other
software applications, or reinsert them back into your movies as still images. You
can also import them into title images with the title editor, TitleDeko. For more
details on using TitleDeko to insert grabbed frames as video images, refer to
Chapter 9.
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Here are some examples of using the Frame Grabber:

• Edit grabbed images back into a video production using overlay or full screen
effects. For example, you can point your camera at your old family photos, grab
images of them, and insert them into your movie (Hint: use a tripod).

• Grab still pictures from any video source, including any videotape, TV, video
games, etc.

• Turn your camera into a scanner by pointing it at photos or documents and
grabbing a picture. You can place documents on a copy stand or just tape them
to a wall (Hint: use a tripod).

• Save grabbed images for use in desktop publishing programs, including page-
layout software, paint programs, word processors, e-mail, and Web pages.

About Grabbing Images

You can choose a frame to grab from one of two sources:

• From movie (a captured video file already on your hard drive)

• From video input (live camera or other video source)

After you grab the frame, the Frame Grabber offers two options for using it:

• Add To Movie (add it to the Video track)

• Save To Disk (save it to your hard drive as a graphic file)

Adding it to the Video track places the grabbed frame before the video clip that is
currently selected. When you save to your hard drive, a full-resolution image is
stored. You can save the file in most standard graphic formats.

Using the Frame Grabber Tool

Open the Toolbox and click the Frame Grabber button. Use the Frame Grabber
tool in conjunction with the Player. Play your video until you see the frame you
want, and grab the frame, which is displayed in the Preview window. Once the
frame is grabbed, you can add it to the movie or save it to disk.
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Reduce Flicker

If the source video of the frame grab contains a large amount of motion, the
grabbed frame may show flickering, which can be reduced or eliminated by
clicking the Reduce Flicker checkbox. Because Reduce Flicker reduces resolution,
you are given the option of turning it on or off.

To grab a frame from a video source and add to a movie:

1 Select File > New Project from the main menu bar to clear the Movie window.

2 Drag a few video scenes from the Album onto the Video track and select the
one in front of which Studio is to place the grabbed frame.

3 Click the Open Toolbox button  and then the Frame Grabber button  .

The Frame Grabber tool is displayed in the Toolbox.

4 Verify Studio is receiving your source video.

5 Select From video input.

6 Play the source video to the frame you wish to capture.

7 Click the Grab Frame button.

8 Click the Add to Movie button

Studio places the grabbed frame on the Video track of your movie in front of
the video clip you selected.

Continue on to the next example without making any changes to Studio.

To grab a frame from a movie and save it:

Saving a grabbed frame is a nearly identical process, except you click the Save to
Disk button instead of the Add to Movie button.

1 Select the From Movie button.

2 Use the Player control to locate the frame you wish to grab.

3 Click Grab Frame.

4 Click the Save to Disk button.
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A Save File dialog box appears.

5 Choose the file folder in which to save the image. Give the file a name you’ll
recognize later by typing in a name in the file name box. Save the file.

6 The default file type is BMP. To choose another file type, click the pull-down
arrow to drop down the file type list. Scroll down to select a file format.

7 Choose the resolution for the image.

8 Click the Save button.

TRIMMING STILL IMAGES

Still images are trimmed in one of two ways:

• Directly on the Timeline

• With the Change Clip Properties tool

Trimming on the Timeline

Trimming still images directly on the Timeline works like trimming scenes on the
Timeline: grab the left or right edge and drag.

If you are having difficulty manipulating these edges, refer to Chapter 6 for a
detailed explanation of trimming on the Timeline.
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Trimming with the Change Clip Properties Tool

Double-click on the image while in Timeline view to display the Change Clip
Properties tool. Because there is little about a still image that can be changed, the
Change Clip Properties tool offers only two options for still images.

• To set the length the still image is displayed, change the fields in the Duration
counter.

• To give the image a custom name, type the name in the Name field.

Still Image

Name field Duration field

Enabled only
for titles

• For titles, the Edit Title button is enabled. To edit a title, click this button. The
title editor, TitleDeko, opens with that title in its editing window, ready for
you to make changes. Click the Accept button when you are finished. The
revised title appears in the Movie window.
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Chapter 8: Adding and Using Transitions

Studio offers sophisticated video effects called transitions that give your movie a
professionally-produced look. Once you begin to use transitions, you’ll recognize
many of these effects in professionally-produced videos. This chapter explains
transitions, and shows you how to add them to your movie. It also explains how
to use them with still images, explained in the previous chapter, and with titles,
which are created with TitleDeko, the built-in Studio title editor. A detailed
explanation of TitleDeko is found in the next chapter.

Transitions are placed on the Video track between two video clips, between full
screen graphics, or between a combination of these clip types. Transitions can also
be placed on the Title Overlay track, to bring titles on and off the screen.
Transition types include Fade, Dissolve, Wipe, Slide and Push. Studio offers
numerous variations of Wipe and Slide transitions. For all transitions, except
Fade, you can set the duration and direction to suit each movie’s specific
requirements. The only variable for Fade is duration.

To select the Transitions section of the Album, click the Transitions  tab.

The following example illustrates a Slide Right  transition.

 ➧  ➧ 

Transition Types and their Uses

Use Transitions based on the content of the video and what you are trying to do
with your movie. Properly used, transitions let you subtly reinforce the meaning
of the movie without the audience becoming aware that a transition is employed.
If you watch professionally-produced video on television, you’ll see many ways
to improve your own movies.
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Generally, it is advisable to refrain from overusing transitions that tend to cause
abrupt changes or otherwise draw attention to themselves. There’s a big
difference between a subtle Dissolve from one clip to the next, and employing a
heart-shaped Wipe.

Open and play the file Transitions.sdc to see an assortment of transitions that
were selected to complement the type of video in each scene. Note how different a
Wipe feels compared to a Dissolve.

Cuts

A cut is the absence of a transition, producing an immediate shift from one scene
to the next. Depending on the content you have, this can be very useful.

Fade

This transition fades the first portion of the video clip up from a black
screen, or fades the last of the clip down to a black screen. If Fade is used
between clips, the video clip that is playing fades down. The incoming

video clip then fades up (this is sometimes referred to as a crossfade). The Fade
transition is the first transition in the Transition section of the Album.

Fade is typically used when there is a large break in the continuity. Examples
include fading up from black at the beginning of your movie, or down to black at
the end. It also can be used to indicate a new section has started. For example, a
movie of a play might benefit from fading down to black an the end of one act,
and then fading up from black as the next act opens.

Dissolve

A Dissolve is a gradual change between one video clip and another. The
Dissolve is a widely used transition that avoids abrupt cuts from one clip
to the next. Unless you intentionally want a cut, which can also be

considered a type of transition, consider a Dissolve. While a short Dissolve can
take the edge off a cut, a long Dissolve is useful to suggest the passage of time.
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Wipes

A Wipe appears as if the incoming video clip is wiping over the current
video using one of many directions or patterns. Studio offers a variety
of Wipe transitions, along with numerous variations of each. Some

Wipes draw a lot of attention to themselves, so consider their use carefully.

Slides

A Slide appears as if one video clip is sliding over the previous clip.
Studio offers four types of Slide transitions. Again, the content of the
video and your intention as the producer dictate what type of Slide you

use and how you use it. For example, you might use a Slide Right to begin a scene
of a car entering the screen from the left.

Pushes

A Push appears as if a new video clip is pushing the current clip off the
screen. Studio offers four types of Push transitions.

THE TRANSITIONS ALBUM

Displaying Transition Type

As you move the cursor over the transition icons in the Album, the
cursor changes to a grabber symbol. If you pause momentarily on the
icon, the transition type is displayed. If you leave the cursor on the
transition, the display persists for several seconds.

Previewing Transition Effects

Select a transition icon and watch the Player Preview window. The Player
demonstrates the effects of the transition using the conventions of A and B where
A represents the current clip and B the new clip.
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To see a detailed view, stop the Player and use the Frame Reverse/Forward
buttons to step through the effect one frame at a time.

ADDING TRANSITIONS TO YOUR MOVIE

Transitions are placed on the Video track by dragging them from the Album as
you would add any other item. You can do this in any view. To quickly add
transitions, the Storyboard view can be useful.

Transitions are also trimmed like any other clip. See Chapter 6 for details on
trimming clips.

To add a transition:

The following example shows how to select and place transitions, and how they
look in your movie.

1 Select File > New Project to clear the Movie window.

2 Click the Storyboard View button in the Movie window menu bar. (You can
also use Timeline View.)

3 Click the video scene Album if it is not already selected.

4 Drag at least six scenes onto the Storyboard.

5 Click the Album Transitions tab.

6 Click-hold your mouse on the Fade In or Out transition and drag it in front of
the first scene on the Storyboard.

Release the mouse button. The transition and the first clip are selected. Play
the movie to see the Fade effect.
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7 Next, add the remaining transitions as indicated.

TRIMMING TRANSITIONS

Transitions are trimmed in one of two ways:

• Directly on the Timeline

• With the Transitions Trim tool

Trimming On The Timeline

Trimming transitions directly on the Timeline works in a similar fashion as
trimming Scenes on the Timeline: grab the left or right edge and drag.

Using the Trim Transitions Tool

The Trim Transitions tool works in a similar fashion as the Trim Scenes tool
described in the previous chapter, with a few minor exceptions.

Because they are so similar, this section covers only the differences.

Select at least two scenes from A Day in the Park and drag them to the Timeline or
Storyboard. Then, drag a transition in between two of them. The example on the
following page illustrates the Trim Transitions tool applied to a Push Down
transition.
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To display the Trim Transitions tool, double-click on the transition or select the
transition and click the Toolbox button.

Transport controls

Name field Duration field

Start frame

End frame
Transition type

Click to reverse effect

Trim scrubber

The Start Frame, End Frame, Trim Scrubber and Transport controls, as well as
the Name and Duration fields, work identically to their counterparts for the
Trim Scenes tool.

Next, click-drag the Trim scrubber to the center. As you move the Trim scrubber,
notice that the incoming video appears to slide left from the right edge of the
Preview window.

Reverse Direction Checkbox

You can change the direction of some transitions by checking the Reverse
Direction checkbox.
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Chapter 9: Creating Titles

TitleDeko is an integrated title editor program that allows you to quickly and
easily create professional quality titles and graphics. Studio DC10plus puts the
Emmy® award-winning professional video effects technology of Pinnacle Systems
right in your hands.

You can choose from over 200 different title styles and looks, including neons,
metallics, and more. Titles can contain words, shapes, background colors, and
photos or graphics imported from other programs. TitleDeko offers preset,
professionally-developed styles for quickly making titles, along with virtually
endless custom styling. You can modify titles by adding transitions for a wide
variety of effects, such as titles that fade in or slide, and adjust the duration the
title appears in your movie.

This chapter begins with a brief explanation of how titles are created, then guides
you through several examples of making and modifying titles. Following these
examples are details on more advanced features.

How Titles Are Created

TitleDeko appears in a separate window with its own user interface. It creates titles
that are inserted into your Studio movie. You can also save titles separately for
use in other Studio movies.

You create the title in the TitleDeko window. You type in text, apply a style, and
complete it by resizing, repositioning, rotating, or by adding shapes or pictures.

When you’re done, click the Accept button  (green check mark, upper right
corner) and the title is automatically inserted into the Studio Movie window.

Launching TitleDeko

You can launch TitleDeko in three ways. The manner in which you launch
TitleDeko determines if the title is an overlay or full screen (you can change this
later). A full-screen title is placed on the Video track, and fills the entire screen,
replacing the video. An overlay title is placed on the Title Overlay track, and is
superimposed on the video. Chapter 7, Creating and Using Still Images, explains
these differences.
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Launching from the Movie Window

For an overlay title, double-click on the Title Overlay track where you want the
title to appear. For full-screen titles, right-click on the Video track.

For an overlay title For a full-screen title

Double click in 
the title overlay
track where you 
want the title

Right click in
the Video track
and select TitleDeko

Launching from the Toolbox

Click the Toolbox  button to open it, then click the Title  button. This
displays the Title tool. Click either the Title Overlay  or Full Screen Title

 button.

Launching from the Main Menu Bar

Choose Toolbox > Create Title, then click either the Title Overlay  or
Full Screen Title  button to launch TitleDeko.

THE TITLEDEKO USER INTERFACE

TitleDeko is a separate application with its own user interface that offers menus,
windows and toolbars.

TitleDeko Windows

TitleDeko windows follow standard Windows conventions—you can open, close,
move and resize them.

• The Menu Bar provides menus of commands and other choices (not shown in
illustration). Frequently used commands have Toolbar buttons.

• Toolbars containing Tool Groups that can be “torn off ” or rearranged.

• A Preview window that shows a what-you-see-is-what-you-get (WYSIWYG) view
of your work along with lines denoting a “video safe” area always visible in
your final movie.

• A Preset Styles window that shows the style presets that can be applied to text
and other objects. You can modify the presets and create new ones.

• A Status line that provides information about the tool in use, text cursor
coordinates, whether movement is set to coarse or fine, and so forth.
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Tool Functions

At the top and sides of TitleDeko are two Toolbars that offer fast access to
frequently used TitleDeko functions. In addition, all functions can be selected via
the menus. Frequently used functions also have keyboard shortcuts.

New, Open and Save Files; Cut, Copy and Paste

   /    These are standard Windows functions.

Typographical Characteristics

Before you can change typographical characteristics, select the text you want to
change. Click the drop-down list arrows to chose a typeface and its size

 . To preview the typeface before you select it, click the
Typeface Browser button, then choose the face you want from the browser window.
To make text bold, italic and/or underline, click the respective button    .
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Look Browser / Edit Looks

 Click the Look Browser button to display a window that contains all the
preset looks. Clicking on a specific look applies a set of appearance attributes to
the selected text or object.

 Click the Edit Look button to modify the currently selected look. There are
numerous fine adjustments that are explained in greater detail later.

Grid / Horizontal / Vertical Alignment Browsers

Alignment browser tools are active depending on whether the selected object is
text or a non-text object (such as a circle). For example, you can right-align a
circle, but you can’t justify it like text by spreading out the words and letters.

 Click the Justification Grid button for a browser that gives you a fast way to
align objects.

  To change the horizontal or vertical alignment and/or justification of text
characters, click the respective button and choose the type of alignment you wish.
Note that some alignments also work on objects.

Undo / Redo

  Click Undo to undo the last action. Undo will undo multiple levels of
action, limited only by available memory. Redo undoes the last Undo.

Accept / Reject Title

  Accepts or rejects the title or overlay and returns you to Studio.

Move / Scale, Rotate / Skew

  Depending on how you select the text or object, these tools have different
functions. The cursor will change to show the active function.

Text Kerning / Leading

 Spreads text lines vertically (leading—rhymes with “bedding”), or words and
letters horizontally (tracking), or adds/removes space between individual letters
and words (kerning).

Add Rectangle, Ellipse

  Click to add these shapes. Hold the Ctl key down while drawing the shape
to constrain the shape to a square or circle.
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Insert Picture

 Click to insert an image from your hard disk or other media. Pictures are
treated like objects in that you can scale, skew, and size them. Please note that
pictures get a transparent background only if they contain an alpha channel
(e.g., a 32-bit .bmp).

Replace Background

 Allows you to make adjustments to the color, opacity and other details of the
background, or select a picture to be used as the background.

Additional Menu Commands

Coarse / Fine

From the main menu bar, select Transform > Coarse or Fine to change the
increments used in moving the cursor via the keyboard.

Make Full Screen

From the main menu bar, select Layer > Make Full Screen to enlarge a picture to
fill the screen.

Find, Find Next and Replace

From the main menu bar, select Edit > Find, Find Next or Replace to perform text
search and replace functions analogous to those of a word processor.

LET’S MAKE A TITLE

On the following pages, you’ll find three title examples. Example 1 is nearly
identical to the one in Chapter 4, A Tour Through Studio. If you’ve already
completed this example, just open the sample file Sample1.sdc and continue with
Example 2. The subsequent examples build on this basic title to show more
advanced TitleDeko features.

Example 2 enhances the text in a number of ways including resizing, rotating and
skewing. In addition, this example adds a shape behind the text to which a style is
applied.

Example 3 demonstrates inserting a picture and changing the background color.
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Example 1: Creating a Basic Title

1 Drag the first video scene from the Album onto the Video track.

2 Double-click on the Title Overlay track below the first video clip.

When you finish the title, Studio places it at the point on the Timeline where
you double-clicked.

3 TitleDeko launches and a text I-Beam cursor awaits text entry. Type the words:
A Day in the Park

Next, you will change the type size and apply a new style to it, but you must
first select the text.

4 Press Ctrl+A or use your mouse to click-drag over the text to select it. The text
is now surrounded by a selection box with handles on its sides.

5 A sampling of styles is displayed in the window to the right of the text-entry
window. (If the Style window is not visible, select View > Preset Styles).  Scroll
down to number 5 and click it.

6 The style characteristics are applied to the text.
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7 Click the Move/Resize tool button . To resize the text, press Ctrl+A to select
it, then position the cursor on the lower right handle while pressing the Shift
key to proportionally shrink the text.

Move/resize cursor

8 To center the text, click the Horizontal Justify button  to display its pop-up
choices. Click the Center button  .

9 Your title is centered, and appears as follows:

10 Finally, select the Accept button  (the green check mark).

You return to Studio from TitleDeko. Studio places the title under the first
Video Scene where you double-clicked on the Title Overlay track to launch
TitleDeko. You can add transitions to bring your title on and off the screen.
Click the Player buttons to preview your work.

Title appears where you originally 
clicked in the Title Overlay track
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Example 2: Modifying the Text

In this example, you enhance the title created in Example 1 by rotating and skewing
the text. You don’t need to follow this example exactly. Feel free to experiment.

1 Click the Move/Resize button  . Select the text and position the cursor
anywhere within the text or on the border (except on the handles) so the
cursor is a Move symbol that looks like a cross. Experiment with moving the
text.

2 Next, click the Rotate/Skew button  . Rotate the text.

3 In the following illustration, the text was rotated  , Style 1 applied  ,
made bold  , resized  , and finally skewed by grabbing the upper right
handle with the Rotate/Skew tool  .

4 Next, click the Rectangle button. A white rectangle appears. Click the Move/
Resize button and resize the rectangle like this:  . Click the Rotate/
Skew button, grab the upper right handle and skew the rectangle until it looks
like this . Position the Rotate/Skew cursor over the shape and
rotate it to match the text angle. Click the Style 8 icon. Move the shape over the
text and select Layer > Send to Back from the menu bar.
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Example 3: Inserting a Picture and Replacing the Background

This example shows how to insert a picture and change the background color. A
picture can be a photograph, a frame of grabbed video or a drawing (see

Chapter 7: Creating and Using Still Images).

1 While in TitleDeko, select File > New to clear the Preview window and start a
new title.

2 Click the Insert Picture button  . A standard Windows file dialog box
appears. Navigate to a picture, and double-click it.

3 The picture appears in the Preview window.

4 To change the background color, click the Replace Background button .
Click the Background is a Color Gradient radio button.

To change the gradient, click in each of the boxes. The Color Picker window
appears. Choose the desired color. In this case, the top two and bottom two
boxes were made the same color to create a “ramp” effect that goes from light
at the top to dark at the bottom.

5 Finally, add text that complements the picture.

You are now finished with the examples. The
remainder of this chapter discusses the fine
points of TitleDeko.

Click these boxes and make them a lighter color

Click these boxes and make them a darker color
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SELECTING TEXT AND OBJECTS

TitleDeko is character-oriented. You can select individual characters, words, lines
or pages to change their position, size, or style. Consequently, text selection feels
a little different than in other software, particularly word processors.

To select all text characters or objects:

Type several lines of text, then try the following selection methods until text
selection seems comfortable

• Choose Select All from the Edit menu, or press Ctrl+A, or
click-drag across the text with your mouse. A selection box
with handles appears around all of the text.

Note that if you click on the red dashed like that indicated
the video-safe area, a similar-looking box appears. However,
this box is larger and surrounds the entire image. You have
selected the image area, not the text.

To select a single word or object:

• Double-click the word or object. Or, use the
arrow keys to move the cursor to the beginning
or end of the word, then hold Shift and press the
right or left arrow. A selection border with handles appears around the word
or object.

To select a random section of text spanning more than one line:

• Drag across, then down or up the text, or diagonally.

• Or, position the cursor at the beginning or end of the desired selection area,
and press arrow keys while holding the Shift key. Also, the Tab key moves the
cursor from one word to the next.

Selected text within blocks is denoted by a series of fine
parallel black lines as shown in this illustration. The entire
block is surrounded by a selection border with handles. To
deselect text or objects, click anywhere outside the selected
area.
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FORMATTING TEXT AND OBJECTS

You can format text and objects by choosing a style with preset attributes, or
manually by adjusting attributes such as boldness, size, typeface and spacing.

To select and change the typeface, click the down
arrow and choose the typeface from the drop-down
list, or click the Typeface Browser button  for a
graphical display of typefaces, and double-click the
one you want.

To change the point size of text, type a new value into the Size field or click the
arrow buttons  .

To change text to bold, italic and/or underline, select the text to be changed. For
bold, italic and underline, click the corresponding button in the Editor menu
bar, or use the shortcuts (Ctrl+B), (Ctrl+I) and (Ctrl+U).

Applying Looks to Text and Objects

One of TitleDeko’s most powerful features is its library of preset looks. Looks
include color, texture and transparency attributes that are applied to the face,
edge and shadow of objects. With a click of the mouse you can instantly change
the appearance of an object from glowing purple neon to blue metallic.

To select and change looks, click the Look Browser

button . The Look Browser graphically displays
the looks you can pick. Just double-click the look
you want.

Justifying Text

Justification operates differently in a video character generator than in a word
processor. TitleDeko uses justification controls to position all objects, including
rectangles and ellipses, as well as text. You can Justify objects via menu selections,
buttons, keyboard shortcuts and keypad shortcuts. The next sections explain
how to use these techniques.



C R E A T I N G  T I T L E S  A N D  G R A P H I C S

9-12

Justification Buttons

Three buttons provide access to the same functions: Justify  , Horizontal
Justify  , and Vertical Justify  .

 The Justify button provides the same Bottom, Middle, Top functions as does
the Justify menu, and also has Left, Center, Right controls for each. Click the
Justify button to display a grid that resembles a Tic-Tac-Toe grid. To use the grid,
select the text or object, and click the button that indicates how you want the text
justified, or where you want the object positioned.

0
Justification

Off

1
Bottom

Left

4
Middle

Left

7
Top
Left

2
Bottom
Center

5
Middle
Center

8
Top

Center

3
Bottom
Right

6
Middle
Right

9
Top

Right

The numeric keypad also emulates the functions of the grid, and thus offers a
quick way to position or justify text and other objects, which is particularly
useful if you have many repetitions to do. Hold down the Ctrl key, and press one

of the numbers on the numeric keypad to quickly
justify text (and objects). Notice that the position of
the marker in the grid button changes, as do the
Horizontal and Vertical Justification buttons.

   The Horizontal and Vertical Justify buttons
display controls to manipulate text and objects in
those directions. In addition, these buttons also

contain Full and Spread functions that apply only to text. Select the
text or object, click the button that indicates how you want the text justified or
where you want the object positioned. The choices are obvious except for Full
and Spread.
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Full Horizontal, Full Vertical and Spread Justification

Full horizontal justification makes the text flush or even with both the left and
right sides of the text field box, except for the last line of text which remains left
justified. Full vertical justification makes the text flush or even with both the top
and bottom of the text field box. Spread justification makes all lines of text flush
with both the left and right sides of the text field box, including the last line.

                        

Tools and Selection Handles

Three buttons (Move/Resize, Rotate/Skew, Kerning/Leading) have dual
functions depending on the handle you select. The current function is
denoted by cursor shape. The following text explains these cursor shapes and
how they function on text and other objects. The following section,
Transforming Text and Objects, explains how to access the dual functions of
these tools.

When you select an object, handles appear on the corners and midpoints as
shown in the illustration on the left. In the case of Rotate and Skew, a single
handle appears in the upper right corner as shown on the right.

    

Kerning / Leading Tool

This multifunction tool is used to change several characteristics. The associated
cursors appear only on the handles.

Note: The Kerning and Leading cursors   appear only on the handles.
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Kerning

Kerning is adjustment of the space between words and letters. Kerning is typically
used for very large letters. Some characters in combination with each other
produce spacing that is visually unpleasing.
To kern text, click the Kerning/Leading button, select the characters to kern, hold
down Alt and press the right/left arrows to increase/reduce the space between

selected characters. Or, use the cursor  to drag the handle at either side of the
selected text.

Leading

Leading is the amount of space between lines of text. To change the leading, click
the Kerning/Leading button, select the text, and use the cursor  to drag one of
the handles above or below the text block.

 ➧  ➧
LAYERS

Layers allow you put one object in front of another. To move a layer forward or
backward, select the object. From the Layer menu, choose one of the menu
commands such as Layer > Send Back One Layer, or press its command key
equivalent (Ctrl+[-]).

TRANSFORMING TEXT AND OBJECTS

Move / Resize Tool

Moving

The Move cursor   indicates moving is enabled. It appears everywhere on the
selection box except at the handles.

Resizing

Corner handles  control height and width together; middle handles on the

right or left  control width only; and middle handles on the top or bottom
control height only. Hold down Shift while dragging a corner handle to constrain
the aspect ratio during scaling.
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In the following example, the word in the center has not been changed. The
widths of the words on the left and right are narrowed and expanded
respectively.

 ➧  ➧ 

Rotate / Skew Tool

Rotating

The Rotate cursor  indicates rotating is enabled. It appears everywhere on the
selection box, except at the upper right handle.

Skewing

The Skew cursor  appears only when you position it on the upper right
handle. Use the Skew function to make objects appear slanted.

USING AND MODIFYING STYLES AND LOOKS

About Looks and Styles

As you have seen, applying a look changes the appearance of text and objects. A
look changes how the face, edge and shadow of the object appears. Each of those
has a variety of parameters you can also adjust.

Styles change more than just the face, edge, and shadow. A style includes a look,
plus any other formatting or transformations that can be applied to text or
objects. For example, styles can include typeface, size, and rotation, in addition
to a look.

Applying Looks to Text and Objects

To select and change looks, click the Looks button  . The Look Browser
graphically displays the looks you can pick. Just double-click the look you want.

Editing Looks

To create your own custom effect, change the detail attributes of the current
look. You cannot save your changes in the Looks browser. However, you can save
them as part of a style.
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The look details (face, edge and shadow) each have its own set of attributes such
as color, size and blur, which you change to create a custom look. The face is the
font rendered in the current attributes. The edge is an additional line around the
face, and the shadow is an offset second image of the face and the edge.

Select View > Look Editor, click the Edit Current Look button. The Look Editor
window appears, with a tab for each of the three details.

The Details and Attributes

Most of the Attribute controls are obvious, so the following does not explain those
in depth. In addition, a small preview window in the lower left corner shows your
adjustments, which makes it easy for you to experiment.

Face Edge Shadow

Face, edge and shadow details have several items in common:

• Choice of solid or gradient colors. These operate the same as described later in
this chapter in the section on Backgrounds.

• A Blur slider, which varies the fuzziness of the face, edge or shadow detail. You
can adjust the slider, or type in a precise number.

Face, edge and shadow details differ in these respects:

• The face detail has a checkbox that turns off the face altogether, leaving only the
edge and shadow.

• The edge detail allows adjustment of the edge size or thickness, either with the
slider or by typing in a precise value.

• The shadow detail also allows you to change the direction of the shadow.
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Note that the edge and shadow of some sophisticated custom looks cannot be
modified.

Accessing the Style Window

Styles are accessed in the Style window. Style window

To display the Style window, select View > Preset Styles from the
menu bar. The Style window contains graphic representations
of 24 preset styles. To select a style, click on it.

Creating Your Own Styles

You can replace any of the 24 preset styles with a
style of your own. Create text or an object with
the attributes you want for your new style.
Next, right-click on the preset style you wish to
replace. Select Deposit Current Style Here.

THE BACKGROUND

Backgrounds fill the screen behind all the text and objects. Full-screen titles
always have an opaque background. Overlay titles have either no Background—
in which case the text and objects appear directly on top of the video—or a
semi-opaque background that the video shows through.

Replace Background Window

You control all aspects of the background with the Replace Background window.

Transparent Backgrounds

Select this to create an overlay with no
background. This is the default choice
for overlay titles.

Solid Color Backgrounds

Selecting this creates a background
consisting of a single color. In the case
of an overlay title, this background
could be semitransparent.
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Gradient Backgrounds

Gradient backgrounds consist of two or more colors that are blended smoothly
together. In the case of an overlay title, each color can have its own level of opacity.

To make the top a single color that merges into a single color at the bottom,
choose the same color for both of the top buttons and a different color for the
bottom pair of buttons.

Picture Backgrounds

To use a picture as the background, type in the path name, or click the Browse
button, navigate to the directory that contains the file, and choose the file.

Selecting Colors and Opacity

Colors

To select color and opacity for a solid or gradient background, click on the
corresponding Color button. The Color Picker appears. Except for opacity, the
choices in this screen are self-explanatory and conform to Windows Color Picker
standards.
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Opacity

The following illustrations show that, as you adjust the opacity slider down from
100%, the background becomes increasingly transparent.

TRIMMING TITLES AND GRAPHICS

Titles and graphics are trimmed in one of two ways: directly on the Timeline, or
with the Transitions Trim tool.

Trimming on the Timeline Using Handles

Trimming transitions directly on the Timeline works in a similar fashion as
trimming scenes on the Timeline: grab the left or right edge and drag.

If you are having difficulty manipulating these edges, refer to Chapter 6, Adding
and Adjusting Video Scenes, for a detailed explanation of trimming on the
Timeline.

Trimming with the TitleDeko Tool

To display the TitleDeko tool, select the title and click the Toolbox button.
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The two functions you can perform in the TitleDeko Trim tool are changing the
duration or end point, and renaming the image. The duration is changed by
entering new values in the Duration fields, or by clicking the Up/Down arrow
buttons. You can use the Player to preview the effect. But you must use the
Duration fields. You can also type in a custom name for the image. This name
appears in the Text View of the Movie window.
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Chapter 10: Adding Sound Effects and Music

You can add a great deal of polish to your video by adding background
music, recording voice-overs, and inserting audio effects such as applause.
Studio accesses and plays common digital audio file types. For example, you can
add audio files stored on your hard disk in WAV format, or import audio
directly from an audio CD. In addition, the audio track of all video clips is
captured along with the video, and is always available.

Studio also provides some exciting new features. To complement your movie, you
can record voice-overs and other audio directly from your computer, and
automatically create any length and type of background music.

Audio clips are selected and placed on their tracks in the same manner as video
clips. Once an audio clip is placed on its track, you edit it as you would a video
clip. You can move its location on the Timeline, adjust the volume, and trim
from the beginning or end.

OVERVIEW OF THE TIMELINE AUDIO SECTION

The Movie window contains two tracks on which you may place audio. In
addition, the Video track also contains the audio portion of video scenes.

Audio clips

Audio portion of video scene

Sound effects and voice-over track

Background music track
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Video Scene Audio Track

In addition to the video itself, the Video track also contains the audio captured
with your video. It is part of the scene and cannot be split from it. When you
move or trim a scene, the audio is correspondingly moved or trimmed.

Sound Effects and Voice-over Track

The most common uses for this track are voice-overs and sound effects; however
you can place any WAV file on this track, containing any type of content. Examples
include sound effects such as applause, or music saved in WAV format.

Background Music Track

Use this track to include music from audio compact disks (CDs) and SmartSound
background music. Although SmartSound will always be background music, the
CD audio can be any type of audio. You can also place WAV files on this track.

SELECTING AND PREVIEWING AUDIO CLIPS IN THE ALBUM

Selecting Audio Clips in the Album

Studio offers a variety of ways to select audio clips in the Album. You can Shift-
click to select contiguous clips, Ctrl-click for noncontiguous selections, area select
with the lasso, and use combinations of these techniques. In addition, you can
use the arrow keys to navigate through the Album. Selection techniques follow
standard Windows conventions.

Previewing Audio Clips

You will probably want to preview the audio effects before placing the clips on the
Timeline to get a better feel for their length and how they fit in with your move.
Any audio clip in the Album can be previewed. After you select a clip (or clips),
they play automatically.

PLACING AUDIO CLIPS ON THE TIMELINE

WAV files are placed from the Album whereas CD music, voice-overs and
SmartSound background music are added via their Toolbox tools. The following
two sections explain both techniques.
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Placing WAV File from the Album

Place WAV audio clips on their tracks the same way you would drag a scene from
the Album.

To place a WAV file on the Voice-over and Sound Effect track:

1 Click the Sound Effects Album tab  .

2 The Album displays the section for Sound Effects. The page is populated with
sound files (if you chose to install them).

3 Place your pointer on the CarHorn sound icon and hold it there. A Tool Tip
will pop-up and display a small window letting you know that CarHorn is
0.12 seconds long.

4 Click on the CarHorn sound to preview it.

5 Drag the clip to the Voice-over and Sound Effect track. The clip remains
selected.

6 To hear the sound again, click the Play button.

Leave the Timeline as it is now, and proceed to the next section.

Placing other Types of Audio Using the Toolbox

To Place a CD sound track on the Background Music track:

1 Select File > New Project to open a new file so the Movie window is empty.

2 Click the Toolbox button , then the Background Music button  in the
Tool Selector area.
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The Name and CD Title drop-down lists contain Untitled until you insert a
CD, type in the CD name and select a track. Subsequently, Studio remembers
the CD name and track number.

3 Type in a name for the CD, or click the down arrow button in the CD Title
drop-down list and choose a CD you have previously named.

4 Click the down arrow button in the track drop-down list and select the track
you wish to place in your movie. You can select a portion of the track by
trimming it using the Trim Calipers. For more information on trimming
audio clips, see Trimming Audio Clips at the end of this chapter.

5 Click the Add to Movie button.

The CD track is placed on the Timeline. Note that you can place the audio CD
music clip at any point on the Timeline by first positioning the Timeline
scrubber at that point. If no clip is selected, the CD music is placed at the
beginning. In the following example, the second scene was selected before
clicking the Add to Movie button, and the clip was placed at that point on the
Timeline.

6 To hear the sound clip when it is on the Timeline, click the Play button on the
Player, or double-click the sound clip and click the Play button in the CD Music
Tool.
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CREATING BACKGROUND MUSIC

Without Studio, background music can be difficult to add to a movie. You need
to decide on the right kind of music, and select an exact duration that matches
your video without causing the beginning and end to have abrupt transitions.

SmartSound easily avoids this. SmartSound creates music, automatically and
precisely tailored to your specifications. Need exactly 10 seconds and 24 frames of
a piano solo for your introduction? You can have it with SmartSound.

SmartSound combines a style of music along with a specific type to produce an
appropriate background sound track.

SmartSound consists of two main software components: the program built into
Studio for choosing and controlling music creation, and the sound files
themselves. Because the sound files are large (around 250 Megabytes), the default
install does not include them. If you didn’t install them, and you find yourself
using this feature a lot, you can install these files any time for more convenient
access, or continue to use them directly from the CD to conserve hard disk space.

To create background music with SmartSound:

1 Select the clips to which you which you want the SmartSound added.

2 Click the Toolbox button , then the Create Background Music  button
in the Tool Selector area.

The SmartSound window appears.

3 Choose a style, song and version
from the lists.

To try this out, pick the default style
Classical, song Four Seasons and
version Fresh Air.  The number of
titles appearing in the Version
column depends on the duration of the selected clips. By increasing duration,
more versions may appear in the window.

4 Choose the length of the music in seconds, if you want it to be longer or
shorter than the clips you selected.
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The SmartSound clip is placed on the CD Audio track.

CREATING A VOICE-OVER

Studio makes voice-overs as easy as a telephone call. Just turn on the Voice-over
Recorder and speak into the microphone. You can narrate as you watch the
movie play so your words are in sync with the action on the screen. You can also
use the recorder to record other sounds with your microphone.

Before you can record a voice-over, you need to connect a microphone to the
input jack of your PC sound board.

To record a voice-over:

Before you begin recording, review the video scenes in your movie and decide
when you want the voice-over to begin and end. To see how recording operates,
you can practice the following example without using the microphone.

1 Select Toolbox > Record Voice-over from the main menu bar or click the
Voice-over button  in the Toolbox.

The Voice-over Recording window appears. Note that the Recording lamp is
not lit.
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2 Select the point on the Timeline at which the voice-over is to begin.

You may do this by selecting a clip, playing the movie and stopping it at the
desired point, or moving the Timeline scrubber. Note: You must have at least
one video clip  in the Timeline to record a voice-over.

3 Pick up the microphone and move your cursor over the record button, which
will turn red. Click the Record button —it toggles to a Stop button.

The unlit Recording lamp changes to Standby, then a 3-2-1 countdown so you
are prepared. (Even if you don’t start speaking exactly on cue, you can always
reposition the beginning of the voice-over clip on the Timeline.)

 ➧  ➧  ➧ 

4 When the Recording lamp  lights and the movie begins playing,

begin speaking. As you speak, watch the movie so you can stay in sync.

5 When you are finished, click the Stop button  .

The lamp goes out, and the voice-over clip is automatically placed on the
Voice-over track of the Timeline.

6 Review your voice-over by clicking on it and clicking the Play button.

Voice-over Volume

The recording volume for a voice-over is set when you record the voice-over, and
cannot be changed; however, you can adjust the playback volume at any time.
Recording volume is set with the Recording Volume
slider on the right of the Voice-over window. To the right
of this slider is a volume meter. Watch this meter to make
sure your recording levels don’t get too high or low—the
indicator changes color from green (0-70%
modulation), through yellow, to red. Generally, you’ll
want to to keep your audio peaking in the yellow (71-
90% modulation) and out of the red (91-100%

Green

Yellow

Red

Volume meter
Recording Volume slider
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Recording Quality Options

You can adjust factory-preset values for recording quality. This section provides
a brief summary. See Appendix A for detailed information.

To access these options select Setup > Edit from the main menu bar.

  

Voice-over Recording Options include Channels and Sample Rate adjustments.
These options control the quality of voice-overs or other recorded audio. Set them
at the highest quality level you anticipate needing, but keep in mind that
increasing quality requires more disk space.

ADJUSTING AUDIO VOLUME

Anatomy of an Audio Clip

An audio clip icon on the Timeline has several parts. Clip length is denoted by
the vertical bars. The actual content of the audio is indicated by the waveform. A
continuous type of sound, such as a car engine, would have many pulses packed
closely together. A staccato sound has sets of pulses spaced apart.

Two other lines indicate the normal and adjusted audio levels. The normal, or
unadjusted, audio level of 0 db is the grey line; adjusted audio is the red line.
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Clip length

Adjustment
handle

Symbolic waveform
representation of actual sound

Unadjusted 0 db 
audio level

Adjusted 
audio level

Cursors

The following cursors indicate the operations you can perform:

Move
clip

Adjust
volume

Trim one
direction

Trim either
direction

ADJUSTING AUDIO LEVELS

Audio levels of individual clips can be adjusted directly on the Timeline, or in the
Volume window. Each technique offers its own advantages. Adjusting on the
Timeline gives you a good sense of time versus volume, whereas the Volume
window facilitates adjusting the relative volumes of the tracks with respect to each
other.

Adjusting Audio Clip Volume on the Timeline

The audio level can be adjusted directly within the clip. Use the pointer to move
the red line that represents the audio level.

To raise or lower volume:

1 If you do not have an audio clip on the Voice-over and Sound Effect tracks,
place one there now.

2 Select the clip. Note that the unadjusted (0 db) Volume Level line is dis-
played.
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3 Position the pointer over the Volume line until it becomes an Up/Down arrow.

4 Click-drag the line up to increase the volume.

5 When you release the mouse button, Studio places a volume adjustment
handle at the point where you release the but-
ton.

6 Play the sound to hear the effect of your adjustment.

You can adjust existing points using the same method.

To reset volume level:

Right-click within the audio clip you adjusted. Choose Remove Volume Changes
from the menu. All adjustment points are removed.

Adjusting Audio Levels with the Volume Tool

The Volume tool offers a greater degree of adjustment functionality organized
into one convenient location. The Volume tool operates in a similar way to a

traditional audio mixer. You
can control the volume of the
individual tracks with respect
to each other, on the fly or
with playback stopped. In
addition, you can fade the
audio in or out at any point.
The Volume tool also displays
the volume with meters similar
to those on stereo equipment.

Fade up/down

Volume adjustment Volume meter

Track identifier

Scene
audio

Effects
and 

voice-overs

Background
music
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Tracks are indicated by the symbol in the upper left corner of each section.
Volume is controlled by clicking on the Volume sliders and adjusting them up or
down. The buttons with the ramp symbol fade the volume up or down.

For example, if you’re adding a voice-over, reduce the video clip volume so the
voice-over predominates.

See How It Works

First, populate the Timeline by dragging several video scenes and WAV sound
effects onto their tracks. Add a section of background music or a CD audio track
to its track. Your Movie window should be similar to the following example.

Click the Player Play button . There is a jumble of sound as the three Audio
tracks play over each other. The meters indicate the volume of each track. To
unclutter the sound, experiment with adjusting the volume levels.

As you make adjustments, you can hear the results, and see the effect in the Audio
Level Adjustment line within the clip that is on the track you are adjusting.

Static Volume Adjustment

Next, try static adjustment. Click the Timescale in the Movie window to activate

the Timeline scrubber. Experiment by moving the scrubber  left and
right. Notice how the various displays in the Volume tool and Player Preview
windows change.

Stop at a point on the Timeline. The displays freeze. Now make volume
adjustments using the Volume sliders. Note the effect in the Audio Level
Adjustment line within the clip itself. An adjustment point is added and the line
level is changed.
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On-the-Fly Volume Adjustment

First try making adjustments on the fly. Click the Play button , and—as the
Movie plays—click on the Scene Volume slider and pull it down to the bottom.
The background music predominates. When you come to a point in the movie
where you want to hear the scene audio, raise the slider.

Note that adjustment points are added and the line level is changed to match the
way you moved the Volume slider.

Fade In and Fade Out Buttons

Above each Volume slider is a set of Fade buttons that contain ramp symbols
. Clicking these produces a Fade In or Out at the current position of the

movie. To see this effect, scrub to a location within the movie, click one of the
buttons, and note the result in the corresponding Audio Level Adjustment line.

You may notice that sometimes the Fader buttons are grayed out, which means a
Fade is not possible at this point because the scrubber is at the beginning or end of
a clip.

TRIMMING AUDIO CLIPS

Audio clips are trimmed in one of two ways:

• Directly on the Timeline

• With the Audio Trim tool

Trimming on the Timeline

Trimming audio clips directly on the Timeline works in a similar fashion as
trimming scenes on the Timeline: grab the left or right edge and drag.

If you are having difficulty manipulating these edges, refer to Chapter 6 for a
detailed explanation of trimming clips on the Timeline.
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Trimming with the Audio Tools

The Trim Audio tool works the same way as the Trim Video Scenes tool described
in Chapter 6, with the following exceptions.

To display the Trim tools for audio, double-click on the audio clip, or select the
transition and click the Trim button in Toolbox tool selection area.

Whereas the Trim Scenes tool shows the start/end video frames, the Trim Audio
tool shows the audio clip. In the case of a WAV file audio clip, a waveform that
represents the sound is displayed.

The controls for the WAV Trim tool operate in exactly the same way as those for
the Video Scenes Trim tool. The only difference is that a waveform of the WAV file
is displayed instead of the Start/End video frames.

For CD music, the CD and track names are displayed instead. As with the WAV
Trim tool, the controls operate the same way as in the Video Scenes Trim tool.
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The Trim tool display for background music is a slight variation: The
Background Music tool is displayed, except that the Trim Tool button is selected.
As with the Transition Trim tool, the only adjustments you can make are the
duration and name. Duration is changed by entering new values in the Duration
fields, or by clicking the Up/Down arrow buttons. Trimming does not remove
music. Rather, it generates a new song of the desired length that has a proper
beginning and end.

You can also type in a custom name for the music. This name appears in the Text
view of the Movie window.
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Chapter 11: Making Videotapes and
   Digital Movies

Once you have created the script for your movie, you are ready to share it with
friends and relatives. Studio offers two ways you can share your movie: as a
videotape or as a digital movie. This chapter explains both.

THE MAKE MOVIE MODE

Click the Make Movie button   on the main menu bar. The portion of the
screen above the Movie window changes to display the Make Movie window, with
the controls needed to make a videotape or digital movie. The default display has
the controls for making a videotape. To display controls for making a digital
movie, click the Make File button.

Click for Make
Movie mode

Make Tape Make File

MAKING A VIDEOTAPE

To begin the make videotape process, click the Make Movie button  on
the menu bar.

Make Videotape Process Controls

Two buttons in the lower right corner of the Make Movie window control the
status of the make videotape process. They are: Make Video and Cancel. They
function as their names imply.
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Making a Finished Videotape

First, connect the VCR as follows:

Video outputs

· If you are recording on a VCR that accepts S-Video (such as Hi8 or S-VHS
videotape recorders), connect the  Studio DC10plus’ S-Video output to the
VCR’s S-Video input with a suitable cable (4-pin DIN to 4-pin DIN).

· If you are recording on a VCR that accepts Composite video (such as 8mm or
VHS), connect the Studio DC10plus’ Composite video output to the VCR’s
Composite video input with a suitable cable (RCA to RCA).

· Be sure to select the correct Output filter (Composite or S-Video) on the Make
Video tab in Setup Options.

Audio outputs

· Connect the audio output of your PC’s sound card to the audio input(s) of
your VCR. You’ll need a stereo mini-plug-to-RCA cable which you probably
received with your sound card. If not, one can be purchased at most computer
or consumer electronic stores.

· If your audio is monaural, use the same cable and connect just the  left (white)
RCA output jack to the Audio In of your VCR.

Once you have connected your VCR and prepared a Studio movie, you can begin
the process of making the finished videotape.

You can cancel the make videotape process at any time by clicking the Cancel
button.

To make a videotape:

1 Verify that the VCR is turned on, and that you have inserted a tape cued to
where you wish to begin recording.

2 Click the Make Video button .  Studio begins the make video process by
starting Intelligent Rendering.

Most other digital video editing programs must render the entire movie before
it can be played to video. This can be very time-consuming and can require
large amounts of disk space.
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Using Intelligent Rendering, Studio DC10plus renders only the parts of your
movie where you have added effects (wipes, dissolves, title overlays, etc.).
Intelligent Rendering saves you time and disk space.

Intelligent Rendering works best when all files in a movie are of the same
quality. If this is not the case, Intelligent Rendering converts all lower-quality
files to match the highest-quality file in the movie.

Intelligent Rendering also overcomes the 2 GB file limit in Microsoft Video For
Windows. The duration of your movie is not limited to a single 2 GB file.
Studio can seamlessly output multiple video files which exceed a total of 2 GB.

Intelligent Rendering is entirely automatic, except that you may be asked to
insert another audio CD. During Intelligent Rendering, Studio gives you
complete feedback on the status of the process. It tells you what part of the
Intelligent Rendering  process it is performing via messages in the Status
window.

A status message will inform you that Intelligent Rendering is complete, and
your movie is ready to be played.

3   Press Record on your VTR, then Play in the Preview window. Your movie is
now being output to tape.
Hint: laying 5-10 seconds of black on tape prior to the start of your movie avoids the

“hard record” audio and video disruption common to VCRs without flying erase heads.

Studio gives you a fade up from black using the Fade transition, and sends black to your

VCR while the Edit Line is paused at the beginning of this transition. You can put your

VCR into Record, and allow your recording to stabilize before pressing Play in the

Preview window. If you want to cut from black to your movie rather than fade up,

minimize your fade duration to 1 frame.

Canceling the Make Video Process

You can terminate the recording of the output videotape at any point in the
make video process. Once you do, however, you cannot continue. If you wish to
record a finished videotape of the same movie, you need to restart the Make
Video process.

To abort the make video process, click the Cancel button in the Make Tape
window and the process stops immediately.
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MAKING DIGITAL MOVIES

You can save your Studio DC10plus movie as a digital movie playable on a PC.
You can use your movie in a multimedia presentation on your computer, to send
it to a friend via email, or to put it on a Web page. The Windows standard
format for digital movies is the AVI file.

Studio saves digital movies in the AVI file format. AVI files can be fairly large
because they contain all the video and audio from the various digitized clips in
the Studio DC10plus movie.

An AVI is a complete file unto itself and can be played on any Windows PC and
most other computers. AVI movies can also be imported into other video
applications as video clips.

To make and play a digital movie:

1 Click the Make Movie button  on the main menu bar.

2 Click the Make Movie to File button  on the Make Movie window menu
bar.

3 Type a name for your file in the File Name field.

The default directory in which your file will be saved is C:\Program
Files\Studio DC10+\Movies. You can change this by clicking the File Cabinet
button  and navigating to a new directory.

4 Verify that the Include Video and Include Audio checkboxes are selected.

Options are provided for turning these off because you may want to make an
AVI audio-only file to save the sound as an AVI for import into another
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program. You also might not want to include audio in a video, such as a small
Web page animation, and can reduce the file size by removing audio.

Under each option is the compression setting currently in effect. Compression
settings are discussed after this section.

5 Check the Diskometer to make sure you have enough drive space.

Drive space
free/used

Space this AVI
file needs

Drive space
(free/used)

6 Click the Make File button .

Studio automatically creates the digital movie and saves the AVI file into the
selected folder you named in Step 3, except that the extension is .avi instead of
.sdc.

Checking your Results

Once your movie has been rendered, there are two ways to play it back and
review it:

1 If you rendered your movie using the Studio DC10plus M-JPEG CODEC, and
you have a television or video monitor connected to the Studio DC10plus
board, click the Play button in the Preview window. Your movie will play in the
Preview window and on your television or video monitor.

2 If you wish to view your movie at full-size on your PC monitor, click the Play
button located next to the File Cabinet button on the Make Movie controller.
The Microsoft Active Movie player will launch and play your movie.



M A K I N G  V I D E O T A P E S  A N D  D I G I T A L  M O V I E S

11-6

About Compression

A Studio DC10plus native file (.sdc file type) is essentially an edit list that points
to the clip data, and is quite small. An AVI file (.avi) contains the actual video
frames and other data, and is significantly larger. Compression algorithms are
employed to compact the AVI data, using a software or hardware CODEC
(compressor/decompressor).

The default CODEC included with Studio DC10plus is the Studio DC10+ MJPEG
(16) CODEC. While the  Studio DC10plus MJPEG CODEC is a very efficient
compressor, the files it creates can be played only on a PC that has a Studio
DC10plus board installed. If you want to share digital movies with others, you
should compress your movie in a more universal format such as the Intel Indeo
CODEC. You can use any Video for Windows-compatible CODEC installed on
your PC as long as that CODEC is also installed on the PC which will play your
digital movie.

You have control over several CODEC settings. Files can be greatly reduced;
however, do keep in mind the trade-off between file size and quality: the more
you compress, the more you reduce quality. Both video and audio compression
are adjustable. Video compression adjustments include frame size, frame rate,
and data rate/compression. For audio, you can select a single channel (that is,
monaural) and adjust the sampling rate.

Adjusting Compression Settings

You may want to adjust compression settings because the files are too large, you
want higher quality, or you are creating them for a special purpose, such as Web
files, where you may want a specific frame size and other characteristics.

Compression settings are
changed in the Movie File
Settings dialog box. Click the
Make Movie button ,
then the Make File button 
below the main menu bar and
finally the Settings button

.
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Video Compression Settings

Same as Project Button

To Use the same video quality settings as the highest quality file
in your movie, click the Same as Project button.

Compression

Choose the compressor (CODEC) that is most
suitable for your intended use. The default is Indeo,
which is an efficient and universal compressor found

on all Windows PCs. You can use any other suitable compressor, but be aware
that not all PCs may play the resulting file.

Width and Height

Width and height are measured in pixels. The default setting of
640 by 480 is the resolution at which Studio captures. Decreasing
width and height greatly decreases file size because the amount of

data greatly decreases with the size, but compression reduces the effect. As you
adjust one parameter, the other also changes to maintain a standard 4:3 video
aspect ratio.

Quality/Data Rate

Depending on the CODEC being used, you can adjust
either the quality or the data rate of your movie. The
higher the data rate or quality you choose, the larger

the resultant file.

Frame Rate

The default is the same frame rate at which Studio captures your
video.  29.97 frames/second is the NTSC frame rate. You may want
to set the frame rate to 30 frames/second, or you may want to set

the frame rate lower for applications such as Web video. Increasing the frame
rate above the default value does not increase quality, but does increase file size.
Most Pentium-based computers can play 160 by 120 at 15 frames per second.
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Audio Compression Settings

If you want to keep file sizes to a minimum, audio for many digital uses can be set
to 8-bit mono at 11 KHz. For a general rule, try 8-bit 11 KHz for audio that is
mostly voice-overs, and 16-bit stereo at 22 or 44 KHz for audio that is predom-
inantly music. By comparison, CD-ROM music is 16-bit stereo sampled at
44 KHz. Another way to consider evaluating an audio compression choice is that
11 KHz is comparable to AM radio quality, 22 KHz comparable to FM and 16-
bit stereo, 44 KHz to audio CD quality.

Type

In most cases, you will choose either PCM (Pulse
Code Modulation) or ADPCM (Adaptive Delta
Pulse Code Modulation). See Appendix F for

definitions.

Channels

You may choose between 8- and 16-bit mono and stereo sound.
Sound quality and file size increases as when you add a second
channel or increase bit depth.

Sample Rates

Digital audio is produced by taking small discrete samples of the
continuous analog waveform. The more samples, the better the
sound. For example, audio CDs are recorded at 44 KHz, 16-bit

stereo. Audio can be sampled at 11 KHz for most digital uses, particularly for
voice-overs.
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Appendix A: Changing Default Options

Options are provided to adjust certain factory-preset default values. The default
values work well for the vast majority of situations and hardware. However, you
may wish to modify them to suit either your work style or your specific
equipment configuration.

Audio Options

Audio options are accessed using
the slide-out audio control panel
on the Diskometer.

Capture

This allows you to capture video with or without an
associated audio track.

Volume

This allows you to vary the signal strength (volume level) of
your incoming audio. When you output to tape or save a
digital  movie, the volume level change will be reflected in
that version. Some sound cards do not support the volume
meter. In that case, the volume meter is not displayed.

Balance

This allows you to place incoming audio to the left or
right channel, or balance (center) it equally on both
channels.
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Audio Input

Some sound boards have only a Line input or only a Mic input,
while other sound boards have both a Mic and a Line input. Be
sure to select the input to which your source audio is connected.
Tip: To adjust your sound board’s master input/output audio

levels, choose Start > Settings > Control Panel > Multimedia > Audio.  Click on
Apply to save your choices.

Video Options

Input

This is how Studio chooses between the composite (RCA
female connector) and the S-Video (4-pin DIN female
connector) on your Studio DC10plus board. Even though

you have video connected to the Studio DC10plus board, you must choose the
correct video input with this control.

Brightness

 This adjusts the black-and-white portion of the video signal, also known as

luminance.

Contrast

 This adjusts the difference between a picture's brightest and darkest areas. A

high-contrast image contains crisp blacks and whites, whereas a low contrast-
image is limited to variations in gray tones.

Sharpness

 This is an electronic enhancement to elements of a video image. Moving the

slider up increases the “sharpness” of image edges. Moving it down decreases the
electronic “noise” of a video image.

Hue

 With the slider at the mid-point, color of the incoming video is unaffected.

Moving the slider up shifts the colors of the video towards red, and moving the
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slider down adds green to the video. Hue is analogous to the Tint control on
television receivers.

Note: if you are using PAL video, the Hue slider is not displayed.

Saturation

 With the slider at mid-point, the intensity of color is unaffected. Moving the

slider up increases the color intensity.

Quality

These buttons allow you to easily select
the quality of your captured video. There
are three pre-set qualities, each with its
own frame size and compression ration.

• Good quality is comparable to CD-ROM or
multimedia video:

Frame size: 320 x 240

Data rate/compression: 800 Kb/sec, 23:1

Audio: 44 kHz, 16-bit stereo

• Better quality is comparable to VHS videotape:

Frame size: 304 x 456

Data rate/compression: 1.8 MB/sec, 10:1

Audio: 44 kHz, 16-bit stereo

• Best quality is comparable to SVHS videotape:

Frame size: 608 x 456

Data rate/compression: 3 MB/sec, 6.1:1

Audio: 44.1 kHz, 16-bit stereo

• The forth button selects the Custom quality
setting. This setting allows you to choose any
settings you wish, including data rates up to the
Studio DC10plus’ maximum of 5.9 MB/sec.

You can choose an uncropped frame size (640 x 480) or a cropped frame size
(608 x 456). Note that Studio DC10plus tests your capture hard disk to
determine its maximum possible data rate. Studio will not allow you to select
a data rate that exceeds the hard disk’s capabilities.
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The Options Dialog Box

The options dialog box is accessed by choosing Setup from the Main Menu, and
then any of the four options presented. The Options dialog box contains four
tabs, representing the three
main Studio processes:
Capture, Edit, Make Video/
Make File.

Once you change an option, it remains changed for all subsequent Studio
sessions. There is no master reset. If you want to return to the factory preset
values, use the information in the following sections.

CAPTURE TAB SETTINGS

The Capture Options
tab is divided into two
areas: one for Video
adjustments and
another for Audio.
Changes affect the
entire capture. If you
want to change only
one capture session,
make sure you reset
the values before the
next session.

In making these adjustments, keep in mind that your computer monitor and
speakers contain their own set of adjustments (and other characteristics) that
may affect the apparent brightness of the source video, as well as the audio
volume and quality.

These controls are only available if you have selected Custom quality. If you have
selected one of the three pre-set quality settings, the controls will show you the
pre-set values, but will not allow you to change them.
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Video Capture Options

Frame Size

This is the width and height of the video frame you capture,
measured in pixels. It is important to capture all the video
in one project at the same frame size to avoid both
increased rendering times and loss of picture quality (when
Studio needs to increase a clip’s frame size to match that of
other clips in a project).

Crop

When left unchecked, this allows capturing a full television frame. When checked,
Studio automatically deletes the 10% from the edges of a television frame that is
never seen on home receivers, to save disk space and rendering times.

Horizontal Resolution

You can choose to sample the entire horizontal scan line of each field, or half or
each scan line. Your choice affects the size of your captured video frame.

Vertical Fields

Each frame of video consists of two fields. This option allows capturing both
fields of your source video, or just one. It offers you a trade-off between smaller
captured video file size and captured video quality.

Video Compression

Studio can compress captured video as much as 23:1 (at Good quality) or as
little as 3:1 (at the Custom setting). The lower the compression, the higher the
video quality.

Test Max Rate

This is a Studio feature that automatically tests
whichever drive you choose, and gives you the
maximum video capture data rate video on that
drive. Studio will not allow you to select a capture
rate that exceeds the drive’s capabilities.
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Audio Capture Options

Channels

Keep in mind that higher quality levels increase the size of a
captured movie, and you must capture the audio at the same
quality level you intend to use for your finished movie.

Example: You capture at 8-bit mono, but you make a digital movie with its Audio
Channels options set to 16-bit stereo. The digital movie will contain two 16-bit
channels, however the sound will have been made from an 8-bit mono signal. The
net effect is a larger file size with no increase in quality.

Sample Rate

Sample rate operates in a similar way to Channels: capture at the
highest quality level at which you expect to output. Roughly
speaking, an 11 kHz sampling rate is equivalent to AM radio

quality, 22 kHz is similar to FM radio and 44 kHz to audio CD-ROM quality.
Another way to look at this is that 11 kHz is adequate for voice, but 22 or 44 kHz
is better for music.

98-03-22 03

For the highest possible audio quality, set Channels to 16-bit stereo, and Sample
Rate to 44 kHz. You might want to do this for an audio-only AVI.
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EDIT TAB SETTINGS

Seconds
Frames

The Edit Options tab is divided into four areas: one for durations of certain items
such as fades, one for the quality of voiceover recordings, one for the size of
storyboard thumbnails, and one for Automatic Scene Detection choices.

Duration Options

Duration times are measured in seconds and frames. After 29 frames for NTSC or
24 frames for PAL, the counter increments to the next second.

Transitions and Graphics

This setting controls the time a transition or still image will be visible, unless you
trim it on the Timeline or change the value of its Duration field in the Change
Clip Properties tool. Note that the default time values are different: one second
for transitions; four for graphics. The maximum duration is 10 seconds for
transitions. For still images, it is 59 seconds and 29 (or 24) frames, depending on
whether the video standard is NTSC or PAL.
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Volume Faders

This option changes duration values for the Volume Fade buttons
 found in the Change Volume tool . Specifically, it sets the

amount of time audio volume  is increased or decreased from the
current position to the new volume level.

MAKE VIDEO TAB SETTINGS

Video Settings

Output

This is where you choose what type of video signal you wish to output. You then
should verify that you have the appropriate cable connected to your recording
device.

Audio Settings

The Make Video audio settings default to the highest audio capture quality used
in your project. These settings cannot be changed.
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MAKE FILE TAB SETTINGS

This tab accesses the settings found in the Movie File Settings dialog box. Access
to them is duplicated here for your convenience. For details, refer to the section
titled Adjusting Compression Settings in Chapter 11, Making Tapes and Digital
Movies.
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Appendix B: The Studio DC10plus Control

The DC10plus Control regulates the Studio DC10plus output.  You cannot see
changes you make with the StudioDC10plus Control while a movie is running.
Any changes will take effect the next time you play a movie.

1 Click the StudioDC10plus button on the taskbar to open the StudioDC10plus
Control. To see all of the controls shown above, click on the More button.

2 Make the desired changes.

Output device
Use this option to select the type of device to which you wish to output. You can
choose Composite or S-Video.

Overlay Adjust
Here you can select the overlay quality (high, medium, low) and determine if
you want to view an overlay during playback or not. When you enable the
“Pinnacle logo” check box, the Pinnacle logo is overlaid on the video during
playback.

AVI Cache settings
Note that a large cache can use up a lot of RAM. However, too small a cache may
result in dropped frames when capturing video.
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Synchronized start
If the Synchronized start button has been enabled, a dialog appears when you
start to play back a movie and all frames have been loaded into the cache. When
you click OK, the playback starts immediately. This mode is useful when you
want to record to videotape and wish to avoid delays during playback.

OVERLAY

If  your graphics board supports DirectDraw digital overlay, you will be able to
display live video in a window on your PC monitor. Studio doesn’t use the
overlay function, but other applications might. You can confirm DirectDraw
support by Start > Programs > Studio DC10+ > Tools > Studio DC10+ hardware test.
The window displayed indicated if DirectDraw is found, and if primary and
overlay surfaces are supported.

If digital overlay does not work, go to the Windows 95/98 control panel (Control
Panel > Display > Settings) and change the resolution, color depth, or refresh rate.
You may need to obtain updated drivers for your graphics board.

Depending on the graphics board, horizontal resolution may be limited during
overlay, resulting in the overlay having a grid-like appearance. This grid will only
appear on the overlay, and this limitation has no influence on the quality of the
video you capture or output. Reducing your display resolution and/or color depth
can improve the quality of the overlay.

You define the overlay quality (high, medium, low) in the DC10plus overlay
window (accessible via VidCap32), and specify whether or not you want the
overlay to appear on the monitor during recording. When you enable the
“Pinnacle logo“ check box, the Pinnacle logo appears overlaid on the video, in
the window.
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Appendix C: Tips and Tricks

GENERAL INFORMATION

Studio DC10plus regulates compression so that each frame contains a fixed
amount of data.

The amount of data generated depends on the size and content of the frame. If
the non-visible portions around the image are eliminated (refer to TV-
cropping), the image to be compressed is correspondingly smaller.

The more detail a frame contains, the more compression is required to reach the
specified data rate. For this reason, at a given data rate, frames with less detail
will appear better than frames with more detail.

Video with a high noise level (for example, a tape that has been repeatedly
copied) presents a particular problem. Even if the video itself does not have a
high level of detail, the noise has detail that must still be compressed. The
amount of data represented by the noise may actually be greater than the
amount of data in the image itself. To counteract this problem, use the Sharpness

control  in the Video capture slide-out tray to reduce the apparent noise.

HARDWARE

To use Studio DC10plus effectively, your hardware should be optimally prepared
and configured.

Hard disk

We highly recommend you capture to a UDMA or SCSI hard disk other than the
disk upon which Windows and the Studio software is installed.

Since recording video sequences with S-VHS quality produces up to 5.9 MB/sec
of compressed data, your hard disk should be correspondingly sized and have the
necessary speed.



C-2

T I P S  A N D  T R I C K S

You should calculate that it takes at least two minutes of raw material to produce
one minute of finished video material (fully edited). This corresponds to between
96 MB and 696 MB of data. Added to this is the amount of data required for any
sound you may be adding: each second of high fidelity sound represents 172 KB
of audio data.

Because of their automatic internal calibration, standard hard disks regularly
interrupt the continuous data stream in order to recalibrate themselves. During
capture, however, this is not apparent since images are temporarily stored in
memory. But during playback, only a limited number of images can temporarily
be stored in this manner. For smooth playback, a continuous data stream (with
no interruptions) is required. If not, the image will “jerk” at regular intervals,
even though all frames are present and even if the hard disk is very fast. A/V-
rated drives do not have this problem.

PREPARING YOUR HARD DISK

Prior to capturing video, you should

1 Defragment your hard disk using Start > Programs > Accessories > System Tools
> Disk Defragmenter, or a similar tool.

2 Run ScanDisk (Start > Programs > Accessories > System Tools > ScanDisk).

3 Close all background applications except Explorer, Studio DC10plus, and
SysTray.

Moving files

To ensure the fastest possible playback, you should defragment your hard disk
again after making your movie.

With many hard disks, you can increase the access speed for specific files by
moving them to the start of the disk. If the file is written to the start (outside) of
the hard disk, access to this area is notably quicker than to the end (inside) of the
disk.

You should therefore use an appropriate utility (such as PCTools) to move all
AVI files to the front of the hard disk, ahead of even any “.COM,”  “.EXE,” and
“.BAT” files.
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RAM

The more RAM you have, the easier it is to work with the Studio DC10plus. You
will need at least 32 MB of RAM to work with the Studio application; 64 MB or
higher is recommended.

NEW EQUIPMENT

Motherboard

You should use at least a Pentium 133 system, with burst-capable PCI slots.

Not recommended are motherboards based on the Intel FX chipset, due to the
fact the PCI bus performance on these boards does not meet common
requirements.

Refer also to your computer’s user manual regarding rates.

Hard disk

We recommend Wide SCSI AV hard disks for the best performance when 6 MB/s
video data rate is desired. For data rates up to 4 MB/s, a separate and modern
UDMA  disk is usually adequate.

SOFTWARE

Color depth adjustment

A high Windows resolution, high color depth and high refresh rates may result in
poor overlay quality. Reducing the resolution, color depth, and/or the refresh
rate will improve overlay quality.

The overlay settings effect only the display on the computer monitor, while
recorded sequences will always appear in full color and resolution at the video
output.

Windows 95

To improve system performance under Windows 95, you can make the following
modifications.
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Hard disk settings

Set read-ahead optimization for your hard disk to none. To do this, select Start >
Settings > Control Panel > System, then Performance > File System. Set the Read-
ahead optimization sliding scale to none.

While you are in File System Properties, also select Troubleshooting from File
System Properties, and clilck on the option Disable write-behind caching for all
drives. Click Apply, then Close. You’ll be prompted to re-start your computer for
any changes to take effect.

CD-ROM drive setting

Under Windows 95, you can specify automatic notification for a CD change.
Select Start > Settings > Control Panel > Device Manager, then click on CDROM
and your CD-ROM drive. Select Settings and, under Options, deactivate Auto
insert notification.

Taskbar

Switch the clock on the taskbar to “off.” To do this, right-click the mouse on the
taskbar and select Properties. Deactivate the Show Clock option.

Closing programs/applications

Before capturing or playing back, you should close all other applications and
background tasks.

INCREASING THE FRAME RATE

If your system is unable to achieve an adequate frame rate (25 fps for PAL/
SECAM, 29.97 fps for NTSC), try the following:

Deactivate network driver and applications

Because network options often cause interruptions during recording and
playback, we recommend not working in a network.

Audio recording

Record audio onlyw hen you actually need it, because audio requires a great deal
of processor time during video recording. When recording at the highest Video
Data rate of 5.9 MB/s we recommend a PCI Soundboard.
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DIGITIZING

Improving image quality

The image quality depends on the quality of the video source. S-Video provides
higher quality than do composite sources. Although they are typically more
expensive, S-Video sources deliver better color saturation, sharper color
transitions, and less video noise.

When copying video material, there is an inherent loss of quality. Transferring
video directly from the master (original) videotape to the hard disk maintains
the highest quality.

Format

Decide on one format (one quality level) before you begin a project. This applies
to both the video as well as to bitmaps and animations. This will save you a great
deal of time when you output your movie for recording.

The formats on the different quality levels are:

TV Cropping

When digitizing video images, it is not necessary to include the entire image,
because the frame will contain areas around its borders that are not displayed on
your television screen. These areas can be cropped without the loss of any
information.

Cropping reduces the amount of data, and permits digitizing to be carried out at
a higher level of quality and without dropping frames.
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Data Rate

Studio DC10plus data rate remains constant and is continually adjusted to the
image material. This results in optimum quality.

Whenever there is a scene change, the image content changes dramatically. A
particular problem in this respect is a change from an image with few details to
one with a high degree of detail. If the data rate is too high, such a change can
result in a “dropped frame” (an unrecorded image). For straight cuts, a dropped
frame is unimportant. However, for soft-editing or fade-outs, a dropped frame
will be very obvious. If too many frames are dropped, you should reduce the
data rate.

For the highest quality video editing, no frames should be dropped. For a digital
video that is intended for playback on a computer, individual dropped frames
are less important.

Digital video with audio

When recoding digital video with audio, remember that the audio also takes up
hard disk space:

• CD quality (44kHz, 16-bit stereo) requires about 172 KB/s

• Stereo quality (22 kHz, 16-bit stereo) approximately 86 KB/s

• Mono quality (22 kHz, 8-bit mono) approximately 22 KB/s

The better the sound quality, the larger your files. CD quality is rarely required.
However, the lowest quality rarely provides acceptable audio sequences.

Studio DC10plus and Computer Animation

If you are editing computer animation (i.e., FLC format) with the DC10plus, or
wish to combine them with digital video, please note the following.
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• Failure to do this will result in unnecessarily long rendering times and, after
the rendering, flaws may be visible when the animation is played back.

• Specify TrueColor format
Computer animation in FLC format is saved in 8-bit palletized format. To
save computer animation in Motion-JPEG format, you must convert it to a
TrueColor format (24-bit) before compression.

Compress Motion-JPEG

Before editing computer animation with a video editing program, you should
compress it in Motion-JPEG format. This will dramatically reduce processing
time.

Match frame sizes

Create your animations using the same frame size and image refresh as your
original video:
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Appendix D: Troubleshooting

INSTALLATION

Problem

My computer crashes when I start the DC10plus configuration test or the application,
or crashes during capture.

Solution

Some graphics boards only request 32 MB, while actually accessing 64 MB. The system
maps the DC10plus directly behind the graphics boards, so that the graphics driver is
reaching into the DC10plus area. You must change the graphics board mapping
manually.

If the DC10plus memory area is located directly after one of the graphics board’s
memory areas, you must use the device manager to move the graphics board
memory resources to a different area. For example, the current setting is

graphics board: atF0000000-F1FFFFFF,

DC10plus: at F2000000-F2FFFFFF,

you must move the graphic board memory to, for example E0000000-E1FFFFFF.

Proceed as follows to change the mapping for your graphic board’s memory
area:

1.  From the Start menu and the Settings command, open the Control Panel.

2.  Click the System folder and activate the Device Manager.

3.  In the Device Manager, select Computer and Display Adapters. The current
graphics board is displayed.

4.  Mark the graphics board and click Properties.

5.  In the next window, click on the Resources tab.

6.  Deactivate the Use Automatic Settings control box.

7.  Click on the Change Settings . . . switch.
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 8.  Select a new memory area, then click OK. Windows 95/98 must not indicate
any other conflict, otherwise you must select a different free area.

 9.   Exit the Device Manager.

10. Restart Windows 95, so your changes take effect.

Problem

VSYNC IRQ failed the DC10plus hardware test.

Possible cause

The PCI slot, in which the DC10plus is installed, was not assigned an IRQ in the BIOS.

Solution

If you cannot explicitly assign an IRQ to the PC slot in the BIOS, you must define an IRQ
as AVAILABLE for the PCI bus.

In this case, each PCI board must be assigned an IRQ via the corresponding PCI
slot during installation. The DC10plus requires its own IRQ.

Problem

Hardware was not found during the DC10plus hardware test

Solution

1. From the Start menu and the Settings command, open the Control Panel.

2. Under System, select the Device Manager and the Sound, video and game
controllers option or Other Devices.

3. If necessary, delete the following entry: PCI Multimedia Video device.

4. Restart Windows 95. The following message should appear during startup:

New hardware component detected! Insert data medium.

If this message does not appear during startup, install the DC10plus in a
different PCI slot. If this still does not solve the problem, either the
DC10plus is defective or the video board is having problems with your
system’s motherboard.
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5. Confirm with OK.

6. Place the DC10plus CD-ROM in your CD-ROM drive and enter the drive
identifier for your CD-ROM drive (i.e., D:) in the Windows command line.

7. Click OK

8. Restart the hardware test from the DC10plus configuration program.

OPERATION

Problem
No output to videotape or to my TV monitor.

Possible cause 1

Your DC10plus board can output in Composite or S-Video. Choose the video
signal you want by clicking on the Pinnacle logo in your taskbar, opening the
DC10plus Control. Under Output Device, you choose Composite or S-Video,
then click OK.

Possible cause 2

The AVI file to be output was not compressed with Motion-JPEG.

Solution 2

You must first import this file into Studio. Then use Make Movie to convert it to
an AVI file with Motion-JPEG compression.

PERFORMANCE PROBLEMS DURING DIGITIZING

Problem

Images are missing from the recording.

Possible cause

Your hard disk’s transfer speed is too low.
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Solution

In this case, you must continue reducing the data rate (quality) until no more frames
are dropped.

When working with some UDMA hard disks, the playback may “jump” when an
AVI file is played back at higher data rates. This can be traced back to the fact
that the hard disk carries out a recalibration while reading the file, thus
interrupting playback.

This problem is not caused by the DC10plus, but is the result of the manner in
which the hard disk operates and interacts with other system components.

There are several solutions you can use to increase the speed of your hard disk:

1. From the Start menu and the Settings command, open the Control Panel.

2. Open the System file, then activate the Performance, File System, and
Troubleshooting commands.

3. Activate the Disable write-behind caching for all drives option and click OK.

4. Set the Read-ahead optimization option to None.

In general, this will result in an increase in the data transfer rate. CAUTION: In
some hard disks, this can result in a decrease in the write rate!

6. If your computer is equipped with at least 32 MB RAM, we recommend using
the System, Performance, and Virtual Memory commands to activate the Disable
virtual memory [not recommended] option when recording or playing back
videos.

However, in cases of insufficient virtual memory or when running a very RAM-
intensive program, this will result in the generation of error messages.

PROBLEMS PLAYING BACK AND EDITING VIDEOS

Problem

Video and audio have lost sync after playing 1S minutes.



D-5

Possible cause

Soundboardclock and DC10plus clock are not 100% in Sync. This is an on-going
problem when using separate sound and videodigitizer boards.

Solution

Divide your project in parts of maximum 10 minutes length. If audio- video sync is
already lost after 5 minutes, please use another soundboard.

VIDCAP32

Problem

VidCap32 is not supported by Pinnacle Systems or Microsoft.

Possible cause

This is a “give away” freeware program.

Known problems

The standard VidCap32 setting is to place the capture file on C:\CAPTURE.AVI. To use a
different drive, change the drive designator. Also, remember to type “.avi” following
the name. VidCap doesn’t automatically assign a suffix.

WINDOWS 95/98

Problem

Hardware not found during installation.

Solution

1. From the Start menu and the Settings command, open the Control Panel.

2. Under System, select the Device Manager and the Sound, video- and game
controllers option.

3. Delete the following entry if it exists:
PCI Multimedia Video device, Studio DC10plus, MotionJPEG Capture/
CODEC board.
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4. Restart Windows 95/98.

The following message should appear during startup:

New hardware component detected! Insert data medium.

If this message does not appear during startup, install the DC10plus in a
different PCI slot. If this still does not solve the problem, free up an IRQ for
the DC10plus.

5. Confirm with OK

6. Place the DC10plus CD-ROM in your CD-ROM drive and enter the drive
identifier for your CD-ROM drive (i.e., D:) in the Windows command line.

7. Click on OK.

8. Restart the hardware test from the DC10plus configuration program.

Problem

General crash or error function.

Solution

Make sure the DC10plus driver has been completely installed in Windows 95/98.

Use the Control Panel, Multimedia, Advanced, Video Capture Devices to configure
the Studio DC10plus, Motion-JPEG Capture/CODEC board driver.

The Use this capture device option must be activated if you want to use the
DClOplus to record. If other drivers are listed under Video Capture Devices,
make sure the DO NOT use this capture device option is activated for them.

Problem

Overlay does not work.

Solution 1

Your color depth may be set too high ot too low. Set the color depth to 16-bit in
Display Properties and retry the Hardware test.
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Solution 2

Your desktop area may be set too high. Set the desktop area in Display Properties
to 800 x 600 and retry the Hardware test.

Solution 3

You may be using either a Generic Windows driver or an older version of your
graphics card. Your graphics card driver may also be corrupt. Please contact
your graphics card vendor to ensure you have installed the most current driver
properly. Reinstall your graphics driver with the help of their Technical Support.
Or go to their Web site, download and run the hardware test.

Solution 4

You may not have Direct-X installed properly. Please contact your graphics card
vendor for support on this.
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Appendix E: Image Data Compression

What is JPEG image data compression?

JPEG image data compression is a so-called “lossy” compression procedure, i.e. a
portion of the original data is lost during compression.

JPEG data compression provides considerably higher compression factors than
loss-free procedures. Lossless compression procedures can only compress at a
factor of 2-3, which is not sufficient for storage of video data.

The lower the compression factor, the better the results appear.

How does JPEG image data compression work?

JPEG data compression occurs in the following steps:

4:2:2 Subsampling

The first step of JPEG data compression is the image conversion from the RGB
format (i.e. computer image) to the YUV format. In this format Y contains the
brightness information (luminance), U and V deliver the color information
(chrominance).

Since the human eye can discern differences in brightness better than differences
in color, the Chrominance Subsampling method (reduced scanning of color
information) can be used to capture video. The Studio DC10plus uses the 4:2:2
ratio where there are four bits for brightness information and two bits for color
information: the U and V color information of every second pixel only is used.

A TV image delivers YUV signals so that no information is lost when digitizing
video.

Discrete Cosine Transformation

Each TV image delivers one brightness signal and two color signals per pixel. The
DCT (Discrete Cosine Transformation) converts these signals into a frequency
coefficient containing the color and the brightness information.

Then the signals can be compressed more easily. The Discrete Cosine
Transformation is the most computation-intensive step of the JPEG data
compression. The DCT is lossless.



E-2

I M A G E  D A T A  C O M P R E S S I O N

Quantization

By applying complex mathematical operations, the quantization ensures that
image parts which are important to the human eye are represented precisely and
irrelevant information is represented with less precision.

Run Length Encoding

The Run Length Encoding (RLE) method makes use of the fact that many parts
have the value “zero” after the DCT and the quantization operation have been
applied. Instead of saving all “zeros” individually, “zero” is only saved once,
together with a counter, which states how often it occurs in succession.

Huffman-Coding

The last step of image compression is the Huffman Coding method which makes
use of the statistical properties of the data to be coded. This method evaluates how
often and with what probability certain values occur. Values that seldom occur
receive a long code, while values occurring often receive a short code.

Playback

When playing back video, the JPEG image compression steps occur in the reverse
order.

Studio DC10plus and JPEG image data compression

The Studio DC10plus controls compression so that each image contains a specific
amount of data. The amount of data generated depends on the size and contents
of the image.

If you crop the invisible areas around an image (compare video format, image
cropping), then, consequently, the image that must be compressed is smaller.

If the image is not very detailed (i.e. recording of a landscape), less image data
must be compressed than for very detailed images (i.e. building, synthetic
material). If only a small amount of image data needs to be compressed
(compression factor: low), then the result is better than with large amounts of
image data (compression factor: high).

Blurry image material, such as that created when material is copied several times,
is a problem. Even if the image material itself is not very detailed, the blurriness
must also be compressed. The amount of data needed for this can sometimes
exceed the amount of data needed for just the image.
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Appendix F: Glossary

Multimedia terminology contains computer and video terminology. The most
important terms are defined as follows.

ADPCM

Acronym for Adaptive Delta Pulse Code Modulation. It is a method of storing
audio information in a digital format.

Aliasing

An inaccurate display of an image due to the limitations of the output device.
Typically, aliasing appears in the form of jagged edges along curves and angled
shapes.

Anti-aliasing

A method of smoothing out jagged edges in bitmap images. This is usually
accomplished by shading the edges with similarly colored pixels to the
background, thus making the transition less apparent. Another method of anti-
aliasing involves using higher resolution output devices.

Aspect ratio

The ratio of width to height in an image or graphic. Keeping the aspect ratio
means any change to one value is immediately reflected in the other.

AVI

Acronym for Audio Video Interleaved, standard format for digital video (&
Video for Windows).

Bit

The smallest element of a computer’s memory. Among other things, bits are used
to record the color values of pixels in an image. The more bits used for each pixel,
the greater the number of available colors. For example:

• 1-bit: each pixel is either black or white.
• 4-bit: each pixel can be any one of 16 colors or gray shades.
• 8-bit: each pixel can be any one of 256 colors or gray shades.
• 16-bit: each pixel can be any one of 65,536 colors.
• 24-bit: each pixel can be any one of 16.7 million colors.
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Bitmap

An image format made up of a collection of dots or “pixels” arranged in rows.

CD-ROM

CD-ROMs are mass storage media for digital data, such as digital video. CD-
ROMs can only be read.

Channel

Classifications of information in a data file to isolate a particular aspect of the
entire file. For example, color images use different channels to classify the color
components in the image. Stereo audio files use channels to identify the sounds
intended for the left and right speakers. Video files use combinations of the
channels used for image and audio files.

Clip

Any media type that goes on the Storyboard or Timeline. Can be video scenes,
still video or graphic images, or audio.

Clipboard

A temporary storage area shared by all Windows programs used to hold data
during Cut, Copy, and  Paste operations. Any new data you place onto the
clipboard immediately replaces the existing data.

CODEC

Acronym for Compressor/Decompressor, compresses (packs) and decompresses
(unpacks) image data. There are different compression methods (software
CODECs and  hardware CODECs).

Color depth

Number of bits delivering the color information for each pixel.  In the black-and-
white operation 1-bit color depth means 21=2 colors, 8-bit color depth supply
28=256 colors, 24-bit color depth 16,777,216 =224 colors.

Color model

A color model is a way to mathematically describe and define colors and the way
they relate to each other. Each color models has a specific purpose; the two most
common color models are RGB and YUV.
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Complementary Color

Complementary colors are opposite in value to primary colors. If you were to
combine a color with its compliment, the result would be white. For example, the
complimentary colors of red, green, and blue are cyan, magenta, and yellow
respectively.

COM Port

A serial port located on the back of your computer.

Composite video

Composite video encodes luminance and chrominance information into one
signal. VHS and 8mm record and play back composite video.

Compression

A method for making files smaller in size on disk. There are two types of
compression: lossless and lossy. Files compressed with a lossless scheme can be
restored to their original state with no change to their original data. Lossy
schemes discard data during compression, so the file when reopened is slightly
different (see Appendix E for more detail).

Cropping

Choosing the area of an image to be displayed.

Data rate

Data per second, i.e. amount of data which a mass storage medium (hard disk or
CD-ROM) saves/plays back per second or the amount of data of a video sequence
per second.

Data transfer rate

The measurement of the speed at which information passes between storage
mediums, (ex. CD-ROM or Hard Disk), and the display device, (ex. Monitor or
MCI device). Depending on the devices used, some transfer rates may offer better
performance than others.

DCT

Acronym for Discreet Cosine Transformation. Part of the  JPEG image data
compression: The brightness and color information is saved as frequency
coefficient.
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Dissolve

A transitional effect in which the video is faded from one scene to the next.

Decibel

A unit of sound measurement that expresses the loudness of sound.

Digital video

Digital video stores information bit by bit in a file (in contrast to analog storage
media).

Driver

A file containing information needed to operate peripherals. The Studio capture
driver operates the capture board, for example.

Edit decision list (EDL)

A list of clips and effects in a particular order that will be recorded onto your
output tape or AVI file. Studio allows you to create and edit your own edit
decision list by adding, deleting and reordering clips and effects in the
Storyboard or Timeline view of the Movie window.

Fade To/From Black

A transitional effect that fades up from black at the beginning the clip or down to
black at the end of the clip.

Field

A frame of video consists of horizontal lines and is divided into two fields. All
odd-numbered lines of a video frame are field 1. All even-numbered lines are field
2.

File format

The ways in which a computer stores images or information.

Filters

Tools that alter data to produce special effects.

Frame

A single image in a video or animation sequence. If using full NTSC or PAL
resolution, one frame consists of two interlaced fields.
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Frame rate

Frame rate defines how many frames of a video sequence are played in one
second. The Frame rate for NTSC video is 30 frames per second. The frame rate
for PAL video is 25 frames per second.)

Frame size

The maximum size for displaying image data in a video or animation sequence. If
an image intended for the sequence is larger than the frame size, it must be
cropped or scaled to fit.

Hardware CODEC

Compression method which creates compressed digital video sequences. These
video sequences need a video capture/compression board like the DC10plus to be
recorded and played back. They offer a better image quality than data
compressed with software CODECs.

HiColor

For images, this normally means a 16-bit (5-6-5) data type that can contain up
to 65,536 colors. TGA file formats support images of this type. Other file formats
require prior conversion of a HiColor image into True Color. For displays,
HiColor normally refers to 15-bit (5-5-5) display adapters that can display up to
32,768 colors.

Huffman-Coding

Part of the JPEG image data compression. Seldom-occurring values receive a
long code, while constantly-occurring values receive a short code.

IDE

Acronym for Integrated Device Electronics. A hard drive-interface that combines
all drive control electronics on the drive itself, rather than on the adapter
connecting the drive to the expansion bus.

Image

An image is a reproduction, or picture of something. In this case, the term is used
to describe digitized pictures, consisting of pixels, which can be shown on a
computer display and manipulated by image enhancement software.
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Image compression

Method to reduce the amount of data of digital image and video files.

Interlaced

Interlaced describes the refresh method which the PAL and other TV systems use:
The PAL TV image consists of two image halves (fields) of 3121/2 lines each. The
NTSC TV image consists of two image halves of 2421/2 lines each.

Interleave

An arrangement of audio and video to promote smoother playback and
synchronization or compression. The standard AVI format equally spaces audio
and video.

Irrelevance

Irrelevant (unimportant) information can be eliminated during the image data
compression, since the human eye does not realize that this information is missing.

JPEG

Acronym for Joint Photographic Experts Group. Standard for the image
compression.

Key color

A color made transparent so that a background image can show through. Most
commonly used when overlaying one video sequence on top of another, allowing
the underlying video to display wherever the key color appears.

Key frame rate

A method to help in the compression of video files, which works by assigning
certain frames as key frames whose video data is completely saved at the time of
compression. The video data of any intervening frames between two key frames is
then only partially saved. On decompression these partial frames reconstruct
their data from the key frames (e.g. MPEG).

Laserdisk

Medium which stores analog video. Information on laserdisks can only be read,
not changed.
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Mark In / Mark Out

In video editing, the mark in and mark out times refer to the starting and ending
time codes that identify the portions of clips to be included in the project.

MCI

Media Control Interface. Developed by Microsoft as a means to play audio and
video data. It is also used to connect a computer to an external video source such
as a VCR or laser disc.

Motion-JPEG

Video for Windows format for JPEG-compressed video sequences specified by
Microsoft.

MPEG

Acronym for Motion Pictures Experts Group. Standard for the compression of
moving images.

Non-interlaced

Image refresh method, where the complete image is generated without skipping
lines. A non-interlaced image flickers much less than an interlaced image.

NTSC

Acronym for National Television System Committee. Color TV standard used in
the USA using 525 lines and 60 image fields per second.

PAL

Acronym for Phase Alternation Line.  Color TV standard developed in Germany
using 625 lines and 50 image fields per second.

Parallel port

• ECP (Extended Capabilities Port): supports DMA transfers

• EDP (Enhanced Parallel Port): supports 8-bit bidirectional transfers

• Bidirectional: supports 8-bit write/4-bit read transfers

Pixel

From picture (pix) element (el). Pixels are the smallest elements of a monitor
image.
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Prime colors

The colors that are the basis of the RGB color model: red, green, and blue. By
varying how these colors are blended on screen, it is possible to create color.

Quantization

Part of the JPEG image data compression. Relevant details are represented
precisely, less relevant details for the human eye are represented with less
precision.

Raster

The area of a video display that is covered by sweeping the electron beam of the
display in a series of horizontal lines from upper left to lower right (from viewer’s
perspective).

Redundance

Redundant (superfluous) information can be eliminated during the image
compression. During decompression the images can be restored completely.

Rendering

In digital video editing, rendering is the process where clips are combined with
effects (such as wipes, dissolves, title overlays, etc.) and made into one new clip
incorporating all clips and all effects. This is accomplished frame-by-frame, and
can be a time-consuming process.

Run Length Encoding

The RLE (Run Length Encoding) method is part of the JPEG compression.
Repeating values are not saved individually but with a counter, which states how
often the values occurs in succession.

Resolution

The number of pixels which can be displayed on the monitor horizontally and
vertically. The higher the resolution, the more details can be displayed.

RGB

Acronym for Red, Green and Blue, the basic colors of additive color mixing.
RGB describes the method used in computer technology where image
information is transferred by dividing it into the three basic colors.
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Scaling

Adaptation to the desired image size.

SCSI

Acronym for Small Computers System Interface. SCSI (pronounced “scuzzy”) is
used as a hard disk interface for high-performance PCs because of its high data
rate.

SECAM

Acronym for Sequential Couleur à Mémoire.  Color television system developed
on the basis of the PAL system operating with 625 lines and 50 image halves per
second.

Software CODEC

Compression method to compress digital video sequences which can be played
back without special hardware. The quality of these sequences depends on the
performance of the complete system. VHS quality is not achieved.

Still-Video

Method where cameras digitally store photographs on floppy disks or in the
computer memory.

S-VHS

Improved version of VHS using S-Video to deliver higher luminance resolution,
resulting in sharper pictures than VHS.

S-Video

With S-Video (Y/C) signals, the brightness (luminance or “Y”) and the color
(chrominance or “C”) information are transferred separately, avoiding
modulating and demodulating the video.

Time Code

The time code identifies the position of a frame in a video sequence with respect
to a starting point, (usually, the beginning of the clip). Its usual form is
Hours:Minutes:Seconds:Frame. Unlike a tape counter (which can be “zeroed” or
reset at any point in a tape), time code is an electronic signal written on a
videotape, and is permanent once it is assigned.
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TrueColor

An image that contains enough color to appear true to life. For an image, this
normally means 24-bit color, providing up to 16.7 million colors.

Variable-Length Coding

Part of the JPEG image data compression. Values occurring seldom receive a long
code, values occurring often receive a short code.

VHS

Acronym for Video Home System. System commonly used for home VCRs to
record and play back images and sound using a 1/2" tape. VHS systems use &
composite signals consisting of brightness and color visual information.

VISCA

A protocol used by several devices for controlling external video sources from
computers.

Video-8

Video system using a 8 mm tape. Video 8 recorders generate composite signals.

Video encoder

Converts analog signals into digital information.

Video decoder

Converts digital information into analog signals.

Video for Windows

Video for Windows is a Microsoft Windows system extension which records,
stores and plays back video sequences from hard disk (digital video).

Video scan rate

Frequency with which the video signal is scanned. The higher the video scan rate
the higher the image quality and the lesser the flicker.
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Y/C

Y/C is a signal consisting of two components: Y = Brightness information,
C = Color information.

YUV

Color model where Y delivers the brightness information and U and V the color
information.
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Appendix G: Technical Data

GENERAL

Board

32-bit PCI board with bus-mastering

Processor

ZORAN ZR36060 or similar type

Power supply

Standby: 4 Watt
Operation: 7 Watt

System requirements

Pentium or compatible PC (133 MHz or higher) with a free PCI slot, at least 32
MByte memory (64 MByte or more recommended), sufficient hard disk capacity
for video capture  (preferably on a separate disk). Microsoft Windows 95 Direct
X5.0 or higher. Compatible audio and graphic boards.

TV standards

NTSC (North America), PAL (Australia only)

Colors

Internal color representation always YUV 4:2:2 (24 bit RGB).

Settings

• brightness

• contrast

• saturation

• sharpness

• hue

• cropping

• recording format

• data rate
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CONNECTORS

Video inputs/video outputs

Video inputs (Slot shield)

1 x S-Video input (Y/C, 1.0 Vpp/0.3 Vpp)
1 x Composite video input (RCA; 1.0 Vpp)

Video inputs (internals)

1 x Composite video input (RCA; 1.0 Vpp) 2-pin connector

No. Function

1 Composite
2 Ground

Video output (Slot shield)

1 x S-Video output (Y/C, 1.0 Vpp/0.3 Vpp)
1 x Composite video output (RCA; 1.0 Vpp)

Video output (internal)

1 x Composite video output (RCA; 1.0 Vpp)
2-pin connector

No. Function

1 Composite
2 Ground
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Appendix H: License Agreement

CAREFULLY READ THE FOLLOWING TERMS
AND CONDITIONS BEFORE USING THIS PROD-
UCT. USING THIS PROGRAM INDICATES YOUR
ACCEPTANCE OF THESE TERMS AND CONDI-
TIONS. IF YOU DO NOT ACCEPT OR UNDER-
STAND THEM, YOU SHOULD PROMPTLY RE-
TURN THIS PRODUCT TO YOUR DEALER.

Proprietary Property

This product, the Studio DC10plus program,
Pinnacle Systems’ trademarks, product names,
user manuals, documentation and other sup-
port materials are either patented, copyrighted,
trademarked, constitute valuable trade secrets
(whether or not they or any portion thereof
may be copyrighted or patented) or are oth-
erwise proprietary to Pinnacle Systems. In ad-
dition, this product may contain the propri-
etary property of others which has been li-
censed to Pinnacle Systems (such as fonts,
music and Clip art). You agree not to remove
any product identification or notices of the
proprietary restrictions from Pinnacle Systems’
products or manuals.

License and Prohibitions

You may:

(a) use the enclosed product, the Studio
DC10plus program, and accompanying
written materials (“programming mate-
rials”) in connection with a single com-
puter. A copy of the program is being fur-
nished to you along with this license agree-
ment. If you wish to use this program on
more than one computer, you must license
additional copies of the program;

(b) use the program and accompanying writ-
ten materials on a licensed computer net-
work. A “computer network” is any com-
bination of two or more terminals or com-
puters that are electronically linked and
capable of sharing the use of a single soft-
ware program. A “licensed computer net-
work” is a computer network for which
you have purchased from Pinnacle Sys-
tems, or its dealer, sufficient copies of this
program so that the number of concur-
rent users of this program on the com-
puter network at any given time is not
greater than that number of copies of the
program so purchased;

(c) copy the program once only solely for
backup purposes in support of your use
of the program so long as you prominently
label the backup copy with the appropri-
ate copyright notice;

(d) use the program for your personal use or
in your business or profession. Permitting
unauthorized users access to the program
and program materials is a violation of
this license agreement; and

(e) transfer the program and license to an-
other party if the other party agrees to ac-
cept the terms and conditions of this agree-
ment. If you transfer the program, you
must at the same time either transfer all
copies to the same party or destroy any
copies not transferred. If you transfer pos-
session of any copy of the program to
another party, your license is automati-
cally terminated.
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Prohibited Uses

You may not, without explicit prior written
permission from Pinnacle Systems:

(a) use, modify or transfer the program, or
copy the program in whole or in part, ex-
cept as expressly provided herein;

(b) reverse-engineer, decompile or otherwise
recreate the program in whole or in part;

(c) make copies of or distribute, for profit or
otherwise, or authorize the copying or dis-
tribution of the program or program
materials, except as herein provided;

(d) make alterations to the program or merge
it into any other software;

(e) grant sublicenses and leases or other rights
in the program or program materials to
others;

(f) make verbal or media translations of the
program, in whole or in part, or of the
program materials;

(g) modify the program for use on non-com-
patible hardware;

(h) make telecommunications data transmis-
sions of the program in whole or in part;

(i) distribute or rent the program on either a
permanent or temporary basis to others;

(j) make available any part of the program
or program materials to any third party,
other than your own properly authorized
employees; or

(k) make any alteration, modification, connec-
tion, disconnection, improvement or ad-
justment of any kind to except as explicitly
contemplated in the enclosed program-
ming materials.

It is agreed that the violation by you of any of
the prohibitions described above shall be a
material breach by you of this license agree-
ment, and any attempt to sublicense, assign,
or transfer any of the rights, duties, or obliga-
tions under this agreement, except as expressly
provided herein, is void.

Term

The license is effective until terminated. You
may terminate it at any time by destroying the
program together with all copies in any form.
It will also terminate upon conditions set forth
elsewhere in this agreement or if you fail to
comply with any term or condition of this
agreement. You agree that upon such termi-
nation you will destroy the program together
with all copies in any form.

Limited Warranty

The prduct is provided “as is” without war-
ranty of any kind, either expressed or implied,
including but not limited to the implied war-
ranties of merchantability and fitness for a par-
ticular purpose, with the sole exception of de-
fective diskette(s), DC10plus board, described
below. The entire risk as to the quality and per-
formance of the program is assumed by you. If
the product proves defective, you (and not Pin-
nacle Systems, its Licensors, or its dealers) as-
sume the entire cost of all necessary servicing,
repair or correction.

Program Warranty

Pinnacle Systems warrants to the original lic-
ensee that the diskette(s) on which the pro-
gram is recorded, shall be free from defects in
material and workmanship only for a period
of thirty (30) days from the date of original
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purchase. If a defect covered by this warranty
occurs during this period, and it is returned to
the dealer from whom it was purchased not
later than five (5) days after the end of such
period, the dealer shall, at its option, either
repair or replace the item. This warranty is in
lieu of all other express or statutory warran-
ties, and the duration of any implied warranty,
including but not limited to the implied war-
ranties of merchantability and fitness for a
particular purpose, is hereby limited to said
thirty (30) day period.

Studio DC10plus  Warranty

Pinnacle Systems warrants to the original lic-
ensee that the Studio DC10plus shall be free
from defects in material and workmanship
only for a period of one (1) year from the date
of original purchase. If a defect covered by this
warranty occurs during this period, the lic-
ensee may request a Return Material Authori-
zation (RMA) number from Pinnacle Systems.
Upon receipt of the returned item(s), Pinnacle
Systems shall, at its option, either repair or
replace the item(s). Items returned to Pinnacle
Systems without RMA numbers will not be
accepted. This warranty is in lieu of all other
express or statutory warranties, and the du-
ration of any implied warranty, including but
not limited to the implied warranties of mer-
chantability and fitness for a particular pur-
pose, is hereby limited to said one (1) year
period.

Pinnacle Systems’ and its Licensors’ liability is
limited solely to the repair or replacement of
the enclosed diskette(s) and Studio DC10plus
board, as set out above, and shall not in any
event include damages for loss of use or loss
of anticipated profits, savings, costs, expenses

or other incidental or consequential damages
arising out of the use or inability to use the
program, including without limitation, any
damages arising from data or information lost
or rendered inaccurate, even if Pinnacle Sys-
tems, its Licensors, or its dealer has been ad-
vised of the possibility of such damages.

Pinnacle Systems and its Licensors do not
warrant, guarantee or make any representa-
tions that the functions contained in the pro-
gram will meet your requirements or that the
use or operation of the program or that the
results of such use will be correct, accurate,
reliable, current, uninterrupted or error free;
and you rely on the program and results of its
use solely at your own risk.

Some jurisdictions do not allow the exclusion
or limitation of implied warranties, so the above
exclusion and limitation may not apply to you.
Some jurisdictions do not allow the exclusion
of liability for incidental or consequential dam-
ages so the above exclusion may not apply to
you. This warranty gives you specific rights and
you may also have other rights which vary from
jurisdiction to jurisdiction.

Updates

Periodically Pinnacle Systems may introduce new
versions or releases of the software. To qualify
for notification of the availability of these new
versions or releases and their prices, you must
first complete and return the enclosed program
registration card. All new versions or releases
which are provided to you shall become part of
the program and shall be governed by the terms
of this license agreement.
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L I C E N S E  A G R E E M E N T

U.S. Government Users

If the enclosed program has been acquired on
behalf of any unit or agency of the United States
Government, then the following provisions
apply in addition to the other terms and con-
ditions of this Agreement:

(a) If the program is acquired on behalf of the
U.S. Department of Defense (DoD), the
following legend applies to the program
and accompanying documentation:

RESTRICTED RIGHTS LEGEND

Use, duplication, or disclosure by the Gov-
ernment is subject to restrictions as set
forth in subparagraph (c)(1)(ii) of the

Rights in Technical Data and Computer
Software clause at DFARS 252.227-7013.

Pinnacle Systems, 280 North Bernardo
Avenue, Mountain View, CA 94043

(b) If the program is acquired on behalf of
any unit or agency of the U.S. government
other than DoD, the government agrees
that its rights in the program and accom-
panying documentation will be as defined
in Clause 52.227-19(c)(2) of the FAR.

General

This agreement will be governed by the laws
of the state of California, U.S.A.
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Index

A

Abbreviations and conventions
choosing menu commands  1-3, 1-4
keyboard conventions  1-4

Accept Graphic button [TitleDeko]  9-4
Access speed  F-2
Add Audio CD Music tool  3-10
Adjust Track Volumes tool  3-10
Adjusting audio clip volume  10-9
ADPCM  F-1
Album

overview  3-2
reviewing video scenes  6-2
video scenes  4-2
voice-over and WAV section  4-11,

10-3
Aliasing  F-1
Animation  F-6
Anti-aliasing  F-1
Aspect ratio  F-1
Audio  10-1

adding to tour example  4-11, 4-13
adjusting volume  10-9
Background Music track  10-2
Channels option setting  A-6
clips, anatomy thereof  10-8
Level Adjustment line  10-12
options settings  5-8
overview  10-1
Sample Rate options setting  A-6
supported types  10-1
video scene audio track  10-2
voice-over and sound effects track  

10-2

WAV, adding to Tour example  4-11
Audio compression adjustment, type of

11-7
Audio recording  A-1
Automatic scene detection  5-3. See

also scene detection
AVI  F-1

audio-only file  11-4
file  11-3. See also digital movies
movies

creating  11-3
playing with Active Movie

Controller  4-13
saving as, during Tour  4-13

B

Background [TitleDeko]  9-18
Opacity  9-20
Solid Color  9-19

Background music. See SmartSound
size of install files  10-5
styles, songs and versions  10-5

Background Music track  10-2
Bit  F-1
Bitmap  F-2
Bold button [TitleDeko]  9-11
Brightness  A-2
Buttons, checkboxes, fields, drop-downs,

sliders
Accept Title button [TitleDeko]  9-7
Background Music Duration field  

10-14
Capture button  5-6
Create Background Music tool  10-5
Duration counter  7-7
Duration field [TitleDeko]  9-21
Edit Title button, Clip Properties tool

7-8
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Fade In and Fade Out buttons (Audio
only)  10-12

From Movie button [frame grabber]  7-
6

Grab Frame button  7-6
Help button  1-2
Horizontal Justify button [TitleDeko]

9-13
Justify button [TitleDeko]  9-7,

9-12
Loop button [trimmed scene]  6-10
Make File button  11-1, 11-4, 11-6
Make Movie button  11-1, 11-6
Name field, Clip Properties tool  7-7
Open (Toolbox) button  3-9
Player  3-3
Quality/Size selector  5-3
Record Voice-over button  10-6
Recording Volume slider  10-7
Reduce Flicker checkbox  7-6
Reverse Transition Direction checkbox

8-6
Show Videos tab  6-1
Start Capture button  5-7
Stop (recording) button  10-7
Storyboard View button  4-2
Timeline View button  4-5
Timescale clock pointer  4-5
Timescale scrubber  4-6
Tool Selector buttons  3-9
Tool tips  1-2
Trim Scene Transport controls  6-9
Undo button  3-1
Vertical Justify button [TitleDeko]  

9-13

C

Capture
button  5-6
mode  3-1
mode, introduced  3-11
Options  5-8
Options tab  A-4
window  5-1

Capture Video dialog box  5-7
Capturing video  5-1
CD audio files

placing on the Timeline  10-3
CD quality video  A-3
CD-ROM  F-2

installing Studio DC10plus  2-2
Change Clip Properties tool  3-10
Channel  F-2
Channels, audio compression adjust-

ment  11-8
Channels Option setting  A-6
Character spacing [TitleDeko]. See

kerning
Chrominance  (S-Video) F-9
Clip  F-2
Clip Properties tool

default durations  A-8
Clips

splitting  6-11
Clock  A-4
Coarse setting [TitleDeko]  10-5
CODEC  12-5, A-2
Color depth  2-5, F-2
Combining scenes  6-12
Complementary Color  F-3
Composite video  F-3
Compression  11-5, F-3
Compression

adjusting settings  11-6
of AVI files  11-5
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Compressor/Decompressor. See CODEC
Computer, minimum requirements for  

1-2
Computer system  2-4
Configuration program  2-4, 2-7
Configuration test  2-4
Countdown, during recording  10-7
Create Background Music tool  3-10
Cropping  F-3, A-3
Current position  3-4

Edit line  4-6
Cut (transition type)  8-2

D

Data quantity  A-1
Data rate  A-6, A-3, A-4
DCT  A-1, A-3
Default options

changing  A-1
Defragmentation  2-1
Dialog boxes, windows and menus

Capture Video dialog box  5-7
Capture window  5-1
Make Movie window  11-1
Movie File Settings dialog box  11-6
Movie window  3-5
Preview window  3-2
SmartSound window  10-5
Style windows [TitleDeko]  9-17
Trim Scene Preview windows  6-8
Voice-over Recording window  10-6

Digital movies  3-13
making  11-3

Digital video  F-4
DirectDraw  2-5
DirectX 5.0  1-3
Discrete Cosine Transformation  F-3
Diskometer  3-13, 6-1, 6-2

during make [AVI] file  11-4
Displaying transition type  8-3

Dissolve  8-3
Documents, capturing  7-5
Duration counter

Still Image Clip Properties tool  7-7
Trim Scenes tool  6-10

Duration field [TitleDeko]  9-21

E

Edge detail [TitleDeko]  9-16
Edit decision list  F-4
Edit mode  3-1
Edit Title button

Still Image Clip Properties tool  7-8
Editing

styles [TitleDeko]  9-16
Effects

digital video  8-1
transitions  8-1

Ellipses, adding [TitleDeko]  9-4
Equipment, minimum requirements  1-2
Error messages. See Status line

F

Face detail [TitleDeko]  9-16
Fade  8-2
Fade buttons, audio  10-12
File format  F-4
File types

saving frame grabs to disk  7-7
Filter  F-4
Finding text [TitleDeko]  9-14
Fine setting [TitleDeko]  9-5
FLC file format C-7
Frame Grabber tool  7-4
Frame rate  F-5
Frame size  F-5
From Movie button  7-6
Full Justification [TitleDeko]  9-13



I N D E X

I-4

Full screen still image. See also Title-
Deko explained  9-1

Function fault  2-5

G

Grab Frame button  7-6
Grabbing frames. See Frame Grabber

tool
Graphics. See TitleDeko

H

Hard disk  1-2
Hardware CODEC  F-5
Hardware test  2-4
Help button  1-2, 3-1
Horizontal Justify button [TitleDeko]  

9-13
Huffman Coding  F-2, E-2

I

IDE  F-5
Image  F-5
Image compression  A-5
Image quality  A-3
Images. See still images; TitleDeko
Indeo CODEC  11-5
Insert Picture button [TitleDeko]  9-5
Installing Studio DC10plus

registration  2-2
Interface, explained  3-1
Interlaced  F-6
Interleave  F-6
IRQ VSYNC  D-2
Italic button [TitleDeko]  9-11

J

JPEG  F-6
Justification [TitleDeko]

buttons  9-12

full horizontal, vertical and spread  
9-13

K

Kerning tool [TitleDeko]  9-4, 10-14
Key color  F-6
Key frame rate  F-6

L

Laserdisk  F-6
Layers [TitleDeko]  9-15
Leading [TitleDeko]  9-4, 914
Looks [TitleDeko]

modifying  9-16
using  9-16

Luminance (S-Video)  F-9

M

Make File button  4-14, 12-1,
11-4, 11-6

Make movie
button  11-6
mode  3-1, 11-1
mode, introduced  3-12
windows  11-1

Make movie button  11-1
Make tape

options tab  A-8
starting the process  11-2

Making digital movies  11-1
Making videotapes  11-1
MCI  F-7
Media Player  2-8
Memory area  A-1
Menus. See dialog boxes, windows and

menus
Messages. See Status line
Minimum requirements. See equipment
Mirasor.exe  2-1



I-5

MiroAVI Cache  2-8
Modes

Capture  3-11
Make Movie  3-12

Mono quality  A-6
Motion-JPEG  F-7
Move/Scale button [TitleDeko]  9-4
Movie File Settings dialog box  11-6
MPEG  F-7

N

Name field
Change clip properties tool  7-7

Names, for scenes  6-11
Network operation  A-4
Non-interlaced  F-7
NTSC  F-7

O

On-Line Help 1-2
Opacity [TitleDeko]  9-20
Open/Close [Toolbox] button  3-9
Opening captured video  7-1
Options window  A-4
Output options  4-13
Overlay  7-2, 7-3
Overlay still image. See also TitleDeko

explained  7-2

P

PAL  F-7
Photographs. See still images
Pictures, inserting [TitleDeko]  9-9
Pixel  F-7
Placing clips on Timeline  3-7
Player

controls  3-3
overview of operation  3-2
window, during capture  3-11

Preview window [Player], overview  3-3
Previewing

audio clips  10-2
transition effects  8-3

Problems. See Troubleshooting
(Appendix D)

Q

Quality buttons  5-6
Quantization  E-2, F-8

R

RAM  1-2,
Raster  F-8
Re-detecting scenes  7-14
Record Voice-over button  10-6
Record Voice-over tool  3-10
Recording

lamp  10-7
quality options  10-8
voice-over  10-6
volume  10-7
volume slider  10-7

Rectangles, adding [TitleDeko]  9-4
Red Placement lines  3-8
Redo button  3-1
Reduce Flicker checkbox  7-6
Redundance  F-8
Refresh rate  2-5
Registration [as new customer]  2-2
Registry  2-1
Reject Title button [TitleDeko]  9-4
Replace Background window [TitleDeko]

9-5, 9-18
Resolution A-3, F-8
Reverse Direction [of transition]

checkbox  8-6
Reviewing video scenes in Album  6-2
RGB  F-8
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Rotate button [TitleDeko]  9-4, 9-15
Row spacing [TitleDeko]. See leading
Run Length Encoding F-8

S

S-VHS  F-9
S-VHS quality  A-3
S-Video  F-9
Sample Rate

audio compression adjustment  10-8
options setting  A-6

Saving as an .avi file type  4-13
Scale button [TitleDeko]  9-4
Scaling  F-8
Scene change  5-4
Scenes  4-2

adding and adjusting  6-1
Album section  4-2
Audio track  10-2
creating a custom name  6-11
detection  4-2
displaying start time and length  6-3
re-detecting  6-14
selecting  6-3
splitting  6-11
trimming  6-3
Volume slider  10-10

Scrubbing  4-6
in the Player  3-4

SCSI  F-8
SECAM  F-9
Selecting audio clips from the Album

10-2
Selecting scenes  6-3
Shadow detail [TitleDeko]  9-16
Sharpness  A-2
Skew button [TitleDeko]  9-4
Slide transition  8-3
SmartCapture  5-3

SmartSound. See also background music
adding to Tour example  4-12
creating background music  10-5
custom names for clips  10-14
duration  10-14
size of install files  10-5
styles  10-5

Software CODEC  F-9
Software installation  2-2
Solid Color Background button

[TitleDeko]  9-19
Sound  A-6
Sound. See also audio

effects  4-11, 11-3
Sound quality  A-6
Splitting clips  6-11
Spread justification [TitleDeko]  9-13
Start Capture button  6-7
Stop Capture button  6-7
Status line  3-7

during make tape  11-3
Stereo quality  A-6
Still images  7-1

options tab settings  A-7
photographs  7-1
TitleDeko  9-1

Still-Video  F-9
Stop [voice-over recording] button  10-7
Storyboard view  3-6

button  4-2
introduced  3-5
using during Tour  4-2

Studio DC10plus Control B-1
Styles [SmartSound]  10-5
Styles [TitleDeko]

modifying  9-16
using  9-16

Style window [TitleDeko]  9-17
Subdividing scenes  6-12
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Superimposition
still image  7-2
TitleDeko  9-1

System requirements  1-2

T

Test max rate A-4
Test modes  2-5
Text [TitleDeko]

applying looks  9-16
applying styles  9-16
justification  9-13
selecting  9-10
tools  9-14
typeface and size  9-11

Text view  3-6
custom scene names  6-11
introduced  3-5

Time Code  F-9
Timeline

Placement lines and symbols  3-7
Placing audio clips on  4-11, 11-2
Placing transitions on  4-4
Placing video scenes on  4-3, 4-6
Timeline view

adding scenes and transitions  4-6
button  4-5
introduced  3-5
using during Tour  4-5

Timescale
adjusting  4-5

TitleDeko
adding overlay to Tour example  4-8
duration field, for titles  9-21
overview and capabilities  9-1
tool  9-20

Titles. See TitleDeko
Tool Selector buttons  3-9
Tool tips  1-2

Toolbox  3-8
Scene Trim tool  6-7
Trim Audio tool  10-13
Trim Still Images tool  7-7
Trim Title tool  9-20
Trim Transitions  8-5
Volume Adjustment tool  10-10

Toolbox Open/Close button  3-8
Tools

Add Audio CD Music tool  3-10
Adjust Track Volumes tool  3-10
Change Clip Properties tool  3-10
Change Clip Properties tool [audio

effects]  10-13
Change Clip Properties tool [still

images]  7-7
Change Clip Properties tool [titles]
9-20

Change Clip Properties tool [transi-
tions]  8-5

Change Clip Properties tool [video
scenes]  6-7

Create Background Music tool  3-10
Record Voice-over tool  3-10
Titles and Graphics tool  3-10
Trim Clips tool  3-10
Volume tool  10-10

Tour of Studio DC10plus 4-1
Transitions  8-1

adding to movie  8-4
adding to Tour example  4-4
Album section  4-4
options tab settings  A-7
previewing  8-3
types of  8-2

Transparent background [TitleDeko]  
9-18



I N D E X

I-8

Trim tools
Audio tool  10-13
Change Clip Properties tool  3-10
Scene tool  6-7

Preview window  6-8
Transport controls  6-9

Trim transitions tool  8-5
Trimming  4-7

audio clips  10-12
scenes  6-3
scenes and transitions on Timeline  

4-7
still images  7-7
titles and graphics  9-20
transitions  8-5

Troubleshooting. See also Appendix D
audio quality of digital movies  

5-8, A-1
audio volume of digital movies  5-8,

A-1
brightness of digital movies  A-2
cannot add scenes or transitions to

Timeline  4-6
cannot add WAV files to Timeline  

4-11
preview window is jumpy. See also

Status line
still images default duration too long

or short  A-8
tips to avoid too few or too many

scene changes  5-4
transition default duration too long or

short  A-8
trimming difficulties  6-7

TrueColor  C-7, F-9
Tutorial. See Tour of Studio DC10plus
Typographical characteristics [TitleDeko]

9-3

U

Underline button [TitleDeko]  9-11
Undo/Redo button

Studio multilevel  3-1
TitleDeko  9-4

V

Vertical Justify button [TitleDeko]  9-13
VHS  F-9
Video

compression settings  11-6
opening a captured video  6-1
capture option settings  5-8,

Video encoder  F-10
Video equipment, minimum require-

ments for  1-3
Video for Windows  F-10
Video inputs  5-6
Video outputs  5-6
Video scan rate  F-10
VIdeo scenes. See Scenes
Video-8  F-10
Videotape: making a final tape  11-1
Views (Storyboard, Timeline, Text)  3-5
Voice-over and Sound Effects track  10-2
Voice-overs

editing  10-7
quality options  10-8
recording  10-6

Volume
adjusting for background music  

10-10
adjusting for recording voice-overs  

10-7, 10-10
meter, during recording  10-7
option setting  A-1
slider, video scene  10-12

Volume tool, changing fader default
durations  A-8
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